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Exercicio1
0OS PRIMEIROS PASSOS EM SISTEMAS
DE INFORMACAO GEOGRAFICA

Objetivos
Este exercicio pretende introduzir os conceitos e ferramentas basicas dos

SIG, incluindo a visualizag&o e exploracdo de dados espaciais. E ainda abor-

dado o conceito de camada e efetuada a exploracdo de informacdo espacial
sobreposta, edicdo de simbologia em funcao de atributos e geracdo de
mapas - apresentacao em “Layout”.

Utilizac3o do explorador ArcCatalog, para visualizagdo de dados e metada-
dos.

A. ABRIR E EXPLORAR UM PROJETO ARCMAP

1. Abrit um projeto ArcMap vazio e adicionar uma camada.

1.1 Carregar no botdo Windows e digitar ArcMap, na lista de pro-
gramas apresentada selecionar ArcMap 10.3.1. Na caixa de dialogo sele-
cionar Blank Map em My Templates.

Verificar a informagao que aparece na parte inferior da caixa de dialogo, em De-
fault geodatabase for this map.

Cada projeto ArcMap tem uma geodatabase padréao que corresponde ao local de
origem dos conteudos espaciais do seu mapa. Esse local é usado para guardar
conjuntos de dados e resultados das varias operagdes de edi¢gao e de geopro-
cessamento. Por exemplo, quando exportar informag¢ao de camadas, os dados
serao guardados nesta geodatabase a menos que especifique em contrario, o
mesmo acontece com todos os resultados de ferramentas ou modelos
(http://help.arcgis.com/).
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Nesta mesma caixa de dialogo podera definir uma outra geodatabase, e/ou uma
outra localizagéo para a geodatabase padrao.

Uma geodatabase é uma colecdo de conjunto de dados geogréficos de varios tipos, arquiva-
dos numa pasta de arquivo comum. A geodatabase permite armazenar informacao original-

mente em formatos t3o distintos como shapefiles, tabelas, rasters, grids, imagens, (etc, ...),
num mesmo local.

1.2 Adicionar a shapefile “Limites_politicos.shp”.

1.2.1 Clicar em File ™ Add Data » Add Data ou carregar no simbolo
e navegar até a pasta que contém os dados do exercicio.
Adicionar a shapefile Limites_politicos.shp (Figura 1).

Q Untitled - ArcMap

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

De2Es B8 x HERRED -, 1 - | RO oo | 1| D |10 BB

Q@I X @ MBS TRy

Editor - A 1 of =
z B B ) & B .
Table Of Contents 3 x o
femm | [T g
Lookin: | ] DadasEx1 = = .

] OSPAR_habitats_points_2013.shp
(&) Limites_politicos.shp}

5 atlantic_biological zones.shp

=
2
=

ame: Limites_pottco.shp

Show of type! | patasets, Layers and Results v Cancel

lge|en <
Drawing~ K () ¥ [ - A - 7% [l6) aral vt vB rUlA-H- 2. ..

-485.265 815.324 Unknown Units

Figura 1 - Abertura de um projeto ArcMap e adi¢cdo de uma camada com informagéo espacial.

O projeto ArcMap aberto apresenta agora uma camada, ou tema, de dados de-
signada por Limites_politicos. Esta representa os limites politicos a escala mun-
dial (fonte original ESRI com edig&o IH).

Um projeto ArcMap inclui varios setores (Figura 2), dos quais se destacam: a
tabela de conteudos (a) que apresenta e gere a visualizacao das diferentes
camadas de dados incluidas no projeto; a area de visualizacao (display) (b); a
apresentacgao de coordenadas (c) que varia em funcao da posi¢céo do cursor
sobre 0 mapa; os menus e barras de ferramentas (e) e um campo com algumas
aplicagdes auxiliares minimizadas (d).
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Figura 2 - Projeto ArcMap e principais setores.
1.3 Gravar o projeto na pasta de trabalho.

1.3.1 Clicar em File » Save, ou carregar no simbolo &, e navegar até
a pasta que contém os dados do exercicio. Gravar, e.g., com 0 nome
“OsPrimeirosPassos”.

A extensao .mxd distingue os ficheiros que constituem projetos
ArcMap.

2. Explorar as diferentes ferramentas de pesquisa e visualizagao de dados
disponiveis na Barra de Ferramentas (Tools).

BE[MQ@ 2l e [T @ BN S T E

2.1 Com a ferramenta Identify n verificar que tipo de informacéo é dis-
ponibilizada para diferentes paises.

3. Verificar a informacgao disponivel na tabela de atributos da camada Limi-
tes_politicos. Carregar com BLDR' sobre a camada Limites_politicos e de
seguida em Open Attribute Table.

" BLDR - Bot&o Lado Direito do Rato
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A tabela de atributos que abrir inclui a base de dados, de natureza nao espacial,
associada a camada Limites politicos. Cada um dos registos (ou entradas) de-
sta tabela constitui um pais (ou estado) caracterizado geograficamente pela sua
posicao no mapa e que inclui e.g. o nome do pais e a informagao da sua area.

3.1 Explorar a tabela de atributos através das ferramentas de pesquisa e
exploracao disponibilizada em fung¢ao dos registos (clicar com BLDR sobre
a parte cinzenta de um registo); ou dos seus atributos (clicar com BLDR
sobre um atributo) (Figura 3 e Figura 4, respetivamente).

-o-  Flash
@‘l Zoom To
& PanTo
@ Identify...
[ Select/Unselect
T
g @ Zoom To Selected
L [0  Clear Selected
= i Copy Selected
COUNTRY Shape_Leng area_km2
| | 12.845759 28747.954013
| | 76.852766 2316111.2435
| | Samoa 1.773284 208.112357
| | 1.199443 459.253082
| | T3.415813 | 1251834.11664
| | 09701596 83.288311
— 1625772341 | 12423358 2607
2 | Polygon 9 | Antigua and Barbuda 2878007 437.050454
9 | Polygon 10 | Argentina 225844448 | 277971442348
10 | Polygon 11 | Armenia 151559872 29725.253195
11 | Polygon 12 | Aruba 0.706529 182.566633
12 | Polygon 13 | Australia 723.381023 | 769812410333
13 | Polygon 14 | Austria 26.852621 83750551544
14 | Polygon 15 | Azerbaijan 37.389748 85839.15704
15 | Polvoon 16 | Bahamas 56 965498 13305.848129
oA g m S | (1 out of 247 Selected)

Figura 3 - Fun¢des de exploragao de informagao em fungéo dos registos de dados.

Table o x
Limites_politicos ®
FID | Shape*® | OBJECTID COUNTRY Shape_Leng area_km2 | '
1 | Polygon 2 | Abania 12849759 | 28747964017 =  Sort Ascending
2 | Polygon 3 | Algeria 76852766 | 2316111.243=  Sort Descending
3 | Polygon 4 | American Samoa 1.773284 209.11235° Advanced fast
4 | Polygon 5 | Andorra 1.199443 459.263082 3
| Sort Descending
5 | Polygon 6 | Angola 73.415813 | 1251834.11664 Summarize
& | Polygon 7 | Anguila 0.970196 8329831 - Sort the values in this field in
_ | ¥ Statistics... .

7 | Folygon & | Antarctica 1625772341 | 12423350 260 descending order (Z - 4) (9 -1).
& | Polygon G | Antigua and Barbuda 2 878007 437.050454 [F| Field Calc
9 | Polygon 10 | Argentina 225.044448 | 277971442348 Calculate Geometry...
10 | Polygon 11 | Armenia 15.159872 29725.2531EH1
11 | Polygon 12 | Aruba 0.706529 152_59563:1 Turn Field Off
12 | Polygon 13 | Australia 7233831023 | 7698124.1033]
13 | Polygon 14 | Austria 26852621 | B3750.651544 A T
14 | Polygon 15 | Azerbaijan 37.380748 B85850.15704 ¥  Delete Field
15 | Polvaon 16 | Bahamas 96.965495 13305.848124 I":f N "

o4 oor ow E (D out of 247 Selected) e

Limites_politicos

Figura 4 - Funcdes de exploragéo de informagéo em fungao dos atributos ou caracteristicas.
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3.1.1 Qual o pais com maior area e com menor?

3.1.2 Qual a area dos paises Madagascar e Sérvia? Utilizar a ferramen-
ta de pesquisa Find 8 (atencdo que a designacéao dos paises esta em
Inglés, respetivamente Madagascar e Serbia).

3.1.3 Qual a latitude e longitude aproximada do centro do Uruguai e
Jordania (Uruguay e Jordan em terminologia Inglesa)

Para obter rapidamente informagéao sobre a latitude e longitude de qualquer pais,
podera, por exemplo, colocar o cursor sobre o pais e visualizar as coordenadas
mostradas no canto inferior esquerdo. Para conseguir encontrar o pais rapida-
mente devera fazer de uma pesquisa com a ferramenta Find, ou em alternativa
ordenar alfabeticamente os paises; com o BLDR sobre o pais que pretende
podera fazer Zoom to ou Pan to que rapidamente coloca o centro de visual-
izacao nesse pais.

Se pretender incluir na tabela de atributos descritivos sobre as
coordenadas de cada registo, podera adicionar novos campos a
respetiva tabela (fungao_Add Field disponivel em Table Options), um
campo para cada coordenada e de seguida utilizar a fung¢ao Calcu-
late Geometry disponivel nas agdées para os diferentes atributos (ver

9 Figura 4).

Atencao que estes atributos (e outros que possa calcular desta for-
ma) nao sao dindmicos, i.e. se alterar a forma, posi¢ao ou areas dos
registos as coordenadas nao sao atualizadas de forma automatica.
Para a sua atualizagdo devera repetir o calculo das propriedades
geomeétricas (area, coordenadas, perimetros etc.).

4. Selecao de dados através da area de visualizagao

4.1 Fazer Zoom na Europa e selecionar com a ferramenta Select Feature
I ~ alguns paises do sul da Europa (Figura 5).

4.2 Abrir a tabela de atributos e verificar as opgdes de selecao: Show se-
lected records [=/|, Switch Selection %, Clear Selection E, Zoom To
Selected #8 e Select By Attribute ey .

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL
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Table
ERIE ML
Limites_politicos
FID | Shape® | OBJECTID COUNTRY Shape_Leng
4 | Poygon S [ Andorra 1199443 | 459763082
10 | Povgon 111 | kaly 110412653 | 300502490144
143 [ Polygon 144 [ Wonaco 0.102662 2777817
|| 7% [ Poygon 175 | Portugal 55579556 | 51634.799535
208 [ Polygen 209 Spain 79.221851 | 498084851743

area_km2

o4 0 oM E (5 out of 247 Selected)
Limites_politices

VAN

14°11'STS78'W 11°58'18.458"N

Hnd w7} N

[
|Zle|en <

Number of features selected: 5

Figura 5 - Exemplo de selecédo espacial de registos.

B. ADICIONAR NOVAS CAMADAS

5. Adicionar a shapefile que inclui as zonas biolégicas no Atlantico Euro-
peu.

5.1 Clicar em File ™ Add Data ™ Add Data ou carregar no simbolo e
navegar até a pasta que contém os dados do exercicio.
Adicionar a shapefile atlantic_biological _zone.shp.

5.1.1 Explorar espacialmente a informagao incluida na camada adicio-
nada, utilizar a ferramenta Identify e verificar os conteudos da tabela

de atributos.

C.EDITAR SIMBOLOGIA

6. Modificar a aparéncia das diferentes camadas: Limites_politicos e atlan-
tic_biological_zone.

6.1 Para editar a simbologia fazer duplo clique na camada Limites_poli-
ticos e assim abrir a caixa de propriedades deste tema. Carregar na aba
Symbology e de seguida no padrao de cor para abrir a janela Symbol
Selector (Figura 6).

6.1.1 Alterar a simbologia dos paises, para um padrao que Ihe parecer

adequado.
SISTEMAS DE INFORMAGCAO GEOGRAFICA: ANALISE ESPACIAL
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Este tipo de edi¢cdo de simbologia aplica-se a todas as entidades contidas na
camada.

Layer Properties

General | Source | Selection | Display Symbology | Fields | Definition Query | Labels | Joins & Relates | Time | HTML Popup

Show:
L
i Single symbol
. Symbal
Categories v Type here to search v| @ EE ~  Current Symbol
Quantities . .
Charts Search: (®) All Styles (_)Referenced Styles
Muiltiple Attributes ESRI ~
Legend .
Label appearing next to the symbol in Green Blue sun
Fill Color: l:l | -
. Outline Width: | 0.40 -5
CE E:’ {F .-‘G{q:l\c, Description. .
-
Additional description appearing next Hollow Lake Rose QOutline Color: .|‘
|:| |:| |:| el
Beige Yellow Olive Save As...
Green Jade Blue
Style References...
D D D N OK Cancel

Figura 6 - Campo de edi¢ao de simbologia na caixa de propriedades de uma camada (ou tema).

6.2 Editar a simbologia da camada atlantic_biological_zones em fungao do
conteudo da tabela de atributos. Abrir a caixa de propriedades deste tema,
e na aba Symbology selecionar Categories (no campo Show) (Figura 7).

6.2.1 Alterar a simbologia das diferentes zonas biolégicas em funcao
do campo Name (em Value Field), carregar em Add All Values para
aparecerem todos os valores da tabela de atributos e selecionar uma
rampa de cores que |lhe parecer adequada.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL
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| General | Source | Selection I Display| Symbology | Fields | Definition Guery | Labels | Joins & Relatesl Time I HTML Popup

Show:

|Dra'll categories using unigue values of one field. Import..
Value Field Color Ramp
Unique values | NAME
i+ Unigue values, mary
.. Match to symbolsin a
Quantities Symbol  Value
Charts [w] <l cther values=
Muitiple Attributes <Heading>
I oyssal
Circalittoral
Deep Circalittoral
Infralittoral
Lower bathyal
[ Mid bathyal
[ |Upperbathyal
I:|Upper slope

| Add All Values | | Add Values...

Aplicar

Figura 7 - Campo de edicdo de simbologia, em funcdo de um atributo, na caixa de propriedades de uma camada.

Ao contrario da edicao de simbologia aplicada no ponto anterior, aqui a atribuicao
de um padrao depende de informacao qualitativa descrita na tabela de atributos
da camada (ou tema), i.e. depende dos proprios atributos de natureza qualitativa.

Se, por outro lado, pretender atribuir um padrdo em fungao de atributos quanti-
tativos, devera utilizar a opcao Quantities do campo Show, escolhendo natural-
mente o atributo numérico que quer representar em Fields - value (Figura 8).

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
DRES L E@ x|9 ™| b- (12500000 BiFAf=l=171-hall- BB HFLHIS Y PEY
Q@i+ E-0 /%0 7@ 2 NH2E R

Editor=| » f e Ll S| [N Y e

General | Source | Selection | Display | Symbology | Fields | Defintion Query | Labels | Joins & Refates | Tme | HTML Popup

>
xojo0L01v @

B [orew st using color to show valuss.
Categorics Fields Classfication
Quantities. Value: Enual nterval e
v e ~| cowes 2
Proportional symbols 2
sy | corpa: £
Charts &
Multiple Attributes || Symbel  Range Label ~ ik
I 0 573475 - 840313.404209 0573478 - 840313404209 8
[ 340313404210 - 1680626.234940  840313.4D4210 - 1680626 234340 =
[ 1550626234541 - 1680626.234941 -
3361251896403 3361251.896403
L A [N 3361251.896404 - 4201564 727134 3361251896404 - 4201564.727134
I 4201564727135 - 5041877 557865 4201564.727135 - 5041877.557865
[N 5041877 557866 - 5882190 388596 5041877 557865 - 5882190.388596
| e s

[ Show class ranges using feature values Advanced ~
e .
e 22
ng K 10 A= a0 P S
Drawing~ K () &/ [~ A (0] Azl v[o v[B 1 Ul A £2-2-8

Figura 8 - Exemplo de edicdo de simbologia em fungdo de uma caracteristica numérica (area de cada pais).
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D. EXPLORACAQ ESPACIAL DE INFORMACAQO

7. Adicionar as shapefiles Broadscale_map.shp e OSPARHabitat-
s2014points_PUBLIC.shp, disponibilizadas pela EMODNET - European Ma-
rine Observation and Data Networking.

7.1 Descarregar a informacgao através do sitio de internet da EMODNET
(http://www.emodnet-seabedhabitats.eu/default.aspx), em Access Mapa
Data e Download data layers.

7.1.1 Descarregar os dados com a designacao “OSPAR threatened
and/or declining habitats 2014” e “Predicted broad-scale EUNIS habi-
tats - Atlantic area”.

Podera verificar os termos e condi¢cdes de uso destes dados através da
hiperligacao (visivel na pagina de downloads): EMODnet Seabed Habitats
webGIS Terms & Conditions.

7.2 Adicionar os ficheiros descarregados ao projeto “Os primeiros passos”.
7.3 Verificar o modelo de dados de cada um dos temas adicionados.

7.3.1 Nas propriedades de cada um dos temas carregar na aba Source
e verificar o tipo de geometria. Esta informagao também é faciimente
deduzida pela aparéncia que cada uma das camadas tem na tabela de
conteudos.

8. Editar a simbologia do tema Broadscale_map em fungao do substrato
rochoso e remover o contorno que aparece no respetivo padrao.

8.1 Para remover o contorno do padrao podera carregar individualmente
em cada um dos padrdes e selecionar No Color em Outline Color, ou
dentro da caixa de propriedades de simbologia clicar com o BLDR sobre
um padrao e escolher Properties for All Symbols e escolher No Color
em Outline Color.

9. Editar a simbologia dos habitats OSPAR em fungao do tipo de habitat.
Fazer uma simbologia que seja particularmente distinta para os montes
submarinos (Seamounts).

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL
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10. Explorar a informacgao espacial das diversas camadas sobrepostas.

10.1 Verificar qual o habitat, qual o substrato e qual a zona bioldgica que
caracterizam a posic¢ao Lat: 39.378, Long: -31.884 (coordenadas em graus
decimais).

10.1.1 Utilizar as ferramentas Go To XY ( « ) e Identify.

E. GERAR MAPA LAYOUT (ESQUEMA DE PAGINA)

11. Criar uma imagem com a informagao espacial dos montes submarinos

e zonas biogeograficas (ou em alternativa montes submarinos e substrato),
incluindo legenda com a descrigao das diferentes simbologias, escala grafi-
ca e seta de indicacao de Norte. Tomar como exemplo a Figura 9.

28°0'W 27°0'W 26°0W
1

Legenda
Habitats OSPAR 2013 Zonas biologicas do Atlantico
) Coral gardens - Abyssal
) Deep-sea sponge aggregations - Circalittoral
) Lophelia pertusa l:| Deep Circalittoral
) Lophelia pertusa reefs I:l Infralittoral
) Maerl beds [ Lower bathyal
) Oceanic ridges with hydrothermal vents/fields |:| Mid bathyal
Seamounts [ Upper bathyal

l:l Upper slope

Figura 9 - Exemplo de produto final (Layout) com informagéo de natureza espacial.

v
11.1 Carregar no simbolo @H = 1l € que o direciona para a pagina de

construgcao de esquema de pagina.

11.2 Ampliar uma éarea restrita para a representar, e.g. as proximidades
de um grupo de ilhas do Arquipélago dos Agores (Grupo Ocidental, Grupo
Central ou Grupo Oriental) ou a faixa litoral de Portugal Continental.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL
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11.2.1 Se precisar, alterar a visualizagdo para o modo paisagem
(Landscape), para isso carregar com BLDR na area de layout fora do
esquema de pagina e em Page and Print Setup, escolher Landscape
em Orientation.

11.2.2 Para incluir elementos adicionais ao mapa fazer Insert e esco-
Iher, alternadamente, Legend, North Arrow e Scale Bar. Para alterar
a aparéncia de cada um destes elementos devera clicar com o BLDR
e selecionar Properties.

11.2.3 Adicionar a informacao geografica da area de visualizagéo
através da adicao de grelhas com informagao de latitude e longitude
(graticula, Figura 10). Carregar com o BLDR sobre os limites do dese-
nho e selecionar Properties, na aba Grid faca New Grid e escolher
uma graticula dividida em meridianos e paralelos. Fazer seguinte, e
na aparéncia escolher Labels only com intervalos de 1 grau tanto em
latitude como em longitude.

Fazer seguinte nas opg¢des que se seguem.

Para editar o texto e rétulos ir as propriedades da grelha, selecionar Proper-
ties, na aba Grid fazer Properties.

=]
Data Frame Properties H |9 &

Feature Cache Annotation Groups Bxent Indicators Frame Size and Position
General Data Frame Coordinate System llumination Grids

Reference grids are drawn on top of the data frame in Layout view only.

New Grid...

J— JS— pm— ‘Which do you want to create?
1 1 1

[

(®) Graticule: divides map by meridians and parallels

() Measured Grid: divides map into a grid of map units

() Reference Grid: divides map into a grid for indexing

Grid name: | Graticule

< Anterior Cancelar

QK Cancelar Aplicar

Figura 10 - Exemplo para adi¢gédo de uma grelha com coordenadas nos limites do desenho.
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11.2.4 Exportar a imagem criada para um formato de imagem, em File
» Export Map. Gravar como o nome a sua escolha na pasta de traba-
lho.

11.2.5 Gravar o projeto ArcMap.

Em ArcGIS, utilize sempre nomes de projetos e ficheiros sem ca-

racteres especiais, utilize descrigoes alfanuméricas separadas por

underscore em vez de espac¢os. Nao inicie a denominagao com um

caracter numérico, pois pode originar erros. O mesmo se aplica aos
0 caminhos (paths) de dados e projetos.

Esta pequena “dica” previne muitos erros e falhas de processamen-
to de dados em ArcMap, que na maior parte dos casos ocorre sem
se perceber a razao.

F. VISUALIZAR DADOS EM ARCCATALOG E VISUALIZAR META-
DADOS (OPCIONAL)

O ArcCatalog é uma aplicagao do ArcGis vocacionada para organizar e gerir os dados
de um projeto SIG (ArcGIS). Esta aplicagao funciona como um explorador de pastas e
ficheiros ESRI (shapefiles, rasters e outros) e também de aplicagao para a previsualiza-
¢ao dos dados, propriedades e informacgao adicional, designada por metadados.

As operacgdes comuns de copiar, cortar, colar e renomear aplicam-se a todos os ficheiros
de dados com o mesmo nome (ficheiros principais e respetivos ficheiros auxiliares, como
veremos seguidamente).

12. Iniciar o ArcCatalog.

12.1 Carregar no botao Windows e digitar ArcCatalog, na lista de pro-
gramas selecionar o ArcCatalog 10.3.1.

12.2 Navegar até a pasta de trabalho e ver a lista de ficheiros incluidos na
aba Contents.
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12.2.1 Reconhecer o tipo de geometria dos diferentes dados.

12.2.2 Na aba Preview ver a previsualizacao de cada uma das shape-
files.

Ainda na aba Preview, se na parte inferior deste campo alterar para Pre-
view: Table podera ver a tabela com os atributos de cada uma das shapefi-
les.

12.2.3 Alterar para a aba Description e verificar as informacgdes auxi-
liares aos dados, designadas por Metadados.

Os metadados sao informacao acerca dos dados. Normalmente tém uma
breve descricéo sobre o que sédo, quem os produziu e geralmente, no con-
texto SIG, uma descrigdo sobre o sistema de coordenadas em que se encon-
tram.

Os metadados podem ser criados através do ArcCatalog ou através de ferra-
mentas informaticas para esse efeito, e.g. o MIG editor, que se trata de uma

ferramenta para a produgao de metadados de informagao geografica basea-
dos nas normas e requisitos vigentes, nomeadamente as normas ISO 19115,
19119, 19139 e requisitos do INSPIRE e Perfil Nacional de Metadados (Perfil
MIG) (http://snig.igeo.pt).

13. Navegar até a pasta de trabalho, desta vez, utilizando o explorador do
Windows.

13.1 Verificar os ficheiros que se encontram associados a cada um dos
temas que utilizou neste exercicio.

Os dados ArcGIS geralmente constituem um conjunto de varios ficheiros rela-
cionados que compreendem informacao distinta. O formato nativo da ESRI para
dados de natureza vetorial é a shapefile, este esta representado por um ficheiro
principal que contém a sua geometria, posi¢ao e atributos, num ficheiro com ex-
tensdo ‘.shp’. Associados a este ficheiro (e com o mesmo nome) associam-se fi-
cheiros com extensodes ‘.shx’, ‘.dbf’, e ‘.prj’ que incluem informagao auxiliar, como
a tabela com os atributos (em ‘.dbf’) ou o sistema de coordenadas (em ‘.prj’).

Por outro lado, os dados de natureza matricial (ou raster) apresentam-se no for-
mato nativo GRID aos quais se associam, similarmente, varios ficheiros.
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Exercicio 2.1
PORTUGAL NOMUNDO | TABELAS DE

ATRIBUTOS

Objetivos

0O objetivo deste exercicio é determinar a area territorial de Portugal e a
area correspondente as aguas marinhas portuguesas, tendo por base in-
formacdo geografica oficial disponibilizada pela Direcado-Geral do Territdrio
(DGT) e pelo Instituto Hidrografico (IH).

Ira realizar uma série de tarefas de edicdo e processamento de forma a sim-
plificar, editar, corrigir e extrair a informacdo pretendida, nomeadamente
gerir e editar informacdo das tabelas de atributos, homogeneizar e agregar
informacdo espacial ndo necessaria, fazer edicdo vetorial, rotular informa-
cdo e calcular areas.

Ainda neste exercicio ira ter acesso a informacao referenciada em sistemas
de coordenadas distintos, pelo que realizara tarefas de transformacao e
projecao de coordenadas.

Este exercicio estd distribuido por trés etapas, uma primeira onde se

aborda a problematica dos sistemas de coordenadas (ex 2.2) e finalmente,
uma etapa de edi¢do vetorial (ex 2.3).

A. ABRIR E EXPLORAR UM PROJETO ARCMAP | TABELA DE
ATRIBUTOS

1. Abrir um projeto ArcMap vazio e adicionar as shapefiles “LinhaBase.shp”
“ExtensaoPlataformaContinental.shp”, “MarTerritorial.shp” e “Zona_Eco-
nomica_Exclusiva.shp”, disponibilizadas pelo Instituto Hidrografico (IH).

1.1 Abrir o ArcCatalog e navegar até a pasta que contém os dados dispo-
nibilizados pelo IH, gravados na pasta de trabalho referentes ao exercicio
2, na pasta InstitutoHidrografico. Arrastar as 4 shapefiles para o ArcMap.

Em alternativa, podera adicionar as mesmas shapefiles através do atalho Add
Data.
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1.2 Qual o modelo de dados de cada uma das camadas?

2. Simplificar a informagao da tabela de atributos das diferentes camadas
apagando os atributos com informacao dispensavel. Apagar todos os cam-
pos mantendo apenas, quando exista, o campo Nation.

Os campos FID e Shape, por constituirem informacao essencial de cada uma das
shapefile, ndo sao editaveis nem apagaveis. Para além destes campos cada shapefiles
devera ter pelo menos um outro atributo.

2.1 Abrir a tabela de atributos, de uma das camadas de dados, e carregar
com BLDR sobre o atributo que quer apagar e fazer Delete Field.

Esta agdo apenas permite apagar um atributo de cada vez, por esta razdo a sua
utilizacdo adequa-se para apagar um numero de atributos reduzido. Para apagar
multiplos atributos ao mesmo tempo devera exercer a mesma acgao através de
uma ferramenta propria denominada Delete Field, como se descreve seguida-
mente.

2.2 Selecionar a ferramenta Delete Field do ArcToolbox. Esta encontra-se
no grupo funcional (toolset) das ferramentas de gestdo de dados - Data
Management Tools » Fields » Delete Field (Figura 1, esquerda).

Na caixa que aparece selecionar uma das camadas para o campo Input Table,
selecionar todos os atributos em Select All » OK (Figura 1, direita).

ArcToolbox
®) ArcToolbox
# @ 3D Analyst Tools FEiETE Delete Field
5 @ Analysis Tools
7 @ Cartography Tools ILinhaBase .
5 @ Conversion Tools Drop Fild This tool deletes
5 @ Data Interoperability Tools RCID one or more fields
@ Data Management Tools GRUP from a table,
7 & Archiving feature class,
5 & Attachments OBIL feature layer, or
# & Data Comparison RVER raster dataset.
7 & Dustributed Geodatabase AGEN
7 & Domains FIDN
i) & Festure Class EIDS
1 & :"f”’" LNAM
&)T :sdd Field [V] LNAM REFS N
., Add Incrementing ID Field « ?
« )
< Acsom Defout To Field | selectal || Unselectal || addFied |
#, Calculate End Time
“ Calculate Field
#, Convert Time Field r'e >
“., Convert Time Zone
:\ ‘ Cancel ‘ ‘ Environments... ‘ ‘ << Hide Help ‘ ‘ Tool Help

, Disable Editor Tracking
R I O e

Figura 1 - Ferramenta Delete Field no ArcToolbox
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No caso da camada ExtensaoPlataformaContinental, mantenha a campo ID uma
vez que é o Unico campo existente para além dos campois FID e Shape.

Para encontrar a ferramenta Delete Field no ArcToolbox podera
fazé-lo através da janela de procura (Search ou Ctri+F) [l , digitando
o nome da ferramenta e selecionando o campo Tools. O resultado da
pesquisa indica ainda a toolset onde a ferramenta se encontra orga-

e nizada; uma mesma ferramenta pode porém estar guardada em mais
do que uma toolset.

Este procedimento aplica-se a qualquer ferramenta disponivel no
ArcToolbox.

3. Adicionar um campo de texto a cada uma das tabelas de atributos que
representem areas marinhas, utilizar um nome comum nas trés tabelas e.qg.
“Descritivo”.

3.1 Podera adicionar um campo diretamente na tabela de atributos (Figu-
ra 2, esquerda), ou através da ferramenta Add Field do ArcToolbox (em
Data Management Tools ™ Fields) (Figura 2, direita). Garantir que adi-
ciona um campo com 0 mesmo nome, tipo e comprimento em todas as
shapefiles. Verificar as diferencas dos dois procedimentos descritos.

Table

AT :

B Find and Replace... ® Input Table - Add Field

B Select By Attributes... Adds a new field to a table or the

% Field Name
table of a feature class, feature layer,
raster catalog, and/or rasters with

R Switch Selection FkIgpe attribute tables.

[ SelectAll EX v

| Add Field... Field Precision {optional)

Turn All Figld=o. - Field Scale (optional)

Show Field| Add Field
Arrange Ta Adds a new field to the table. Field Length {optional)
Restore Default Column Widths Field Alias (optional)
Restore Default Field Order
Joins and Relates 3 [[] Field IsNullable (optional)
Related Tabl 3 i "

elated Tables it of 6 St []Field IsRequired {optional)
illy - Create Graph... Field Domain {optional)
4 Add Table to Layout | —

e Reload Cache

& Print..
Reports r
Export... Cancel Environments... << Hide Help Tool Help
Appearance..

Figura 2 - Adicionar um campo diretamente na tabela de atributos (esquerda) ou através da ferra-
menta Add Field no ArcToolbox (direita).
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Os campos de dados das tabelas de atributos podem ser de diversos
tipos em funcao da natureza da informacgao que contém.

Os campos em ArcMap podem ser do tipo: Short Integer, Long Inte-
e ger, Float, Double, Text e Date.

Podera verificar as especificidades de cada um destes tipos através
da ajuda ArcGIS no menu Help em ArcGIS Desktop Help ou ArcGIS-
ResourceCenter (pesquise por “ArcGIS fields data types”).

4. Nos campos adicionados inscrever o nome da respetiva shapefile (e.qg.
Extensao da Plataforma Continental, Mar Territorial, etc). Podera fazé-lo
diretamente na tabela de atributos ou através da ferramenta Calculate Field
em Data Management Tools W Fields:

Neste caso, uma vez que se esta a inscrever dentro da tabela de atributos (ndo se trata
de nomear objetos ou shapefiles), podera utilizar caracteres especiais. Os campos de
uma tabela de atributos também podem ser alterados quando a respetiva camada de
dados se encontra em modo de edicdo. Esta funcionalidade sera abordada mais a frente
nesta formacgao.

4.1 Para inscrever informacao diretamente na tabela de atributos, utilize
o Field Calculator, disponivel ao clicar com o BLDR sobre o campo que
quer preencher. Por se tratar de uma informacao alfanumérica devera
coloca-la entre aspas (Figura 3).

Nesta opcao, se tiver algum(uns) registo(s) selecionados, apenas estes serao
preenchidos.

Table
o R

ExtensacPlataformaContinental

(®) VB Script () Python

Fields: Type:

298

FID " @ Number
Shape -
u Osgring

FID | Shape* | Id Descritivo
0 | Polygon 0 Sort Ascending

Origem Opate

Sort Descending

£
EREE

Advanced Serting...

JvucsTpoEE| T
FES g

e

Summarize...

[ show Coceblock
Origem =
“Extensdo da Plataforma Continental”|

< Field Calculator...

A

alculate Geometry
Field Calculator

(LI | o »

Ty
ExtensaoPlataformaContiner
Populate or update the values of

this field by specifying a

% De calculation expression. If any of
the records in the table are

B Pr| currently selected, only the values
of the selected records will be
calculated.

Fr

About calaulating fields Gear = ==

Figura 3 - Preencher campos de uma tabela de atributos através do Field Calculator.
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4.2 Repetir a acao anterior, mas desta vez utilizando a ferramenta do Data
Management Tools ™ Fields, Calculate Field e verificar as diferencas.

Para além da inscrigcdo de texto nos campos do tipo text, o Field Cal-
culator ou o Calculate Field permitem, quando aplicados a campos

0 numéricos, efetuar multiplas operagdées matematicas com (ou sem)
interacao dos diversos campos numéricos que constituem a tabela
de atributos.

5. Adicionar as tabelas de atributos, das camadas Polygon, dois campos
onde ira calcular as coordenadas (lat. e long.) correspondentes.

5.1 Que tipo de campo de dados devera escolher? Porqué?
5.2 Calcular as posicdes (lat. e long.) para cada registo das camadas de

dados Polygon utilizando o Calculate Geometry, disponivel ao clicar com
o BLDR sobre o campo que quer preencher (Figura 4).

Property: ¥ Coordinate of Centroid

Coordinate System

(®) Use coordinate system of the data source:
|GCS: WGS 1984

() Use coordinate system of the data frame:
|GCS: WGS 1984

Lnits: Decimal Degrees

Calculate selected records only

About calculating geometry

Figura 4 - Calculo de caracteristicas geométricas relativas as camadas de dados.

5.3 Por que razdo nao consegue calcular a area ou o perimetro dos
poligonos de dados?
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Exercicio 2.2
PORTUGAL NO MUNDO | SISTEMAS DE
COORDENADAS

Objetivos

Este exercicio corresponde a continuacdo do exercicio anterior (2.1) em que
o objetivo é determinar a drea territorial de Portugal e a area corresponden-
te as 4guas marinhas portuguesas, tendo por base informacdo geografica
oficial disponibilizada pela Direcdo Geral do Territério (DGT) e pelo Instituto
Hidrografico (IH).

Ira realizar uma série de tarefas de edigdo e processamento de forma a sim-
plificar, editar, corrigir e extrair a informacao pretendida, nomeadamente
gerir e editar informacao das tabelas de atributos, homogeneizar e agregar
informacdo espacial ndo necessaria, fazer edicdo vetorial, rotular informa-
cdo e calcular areas.

Ainda neste exercicio ira ter acesso a informacao referenciada em sistemas
de coordenadas distintos, pelo que realizara tarefas de transformacao e
projecao de coordenadas.

Este exercicio esta distribuido por trés etapas, uma primeira onde se
introduz a gestdo de campos de tabelas de atributos (ex 2.1), uma etapa que

aborda a problematica dos sistemas de coordenadas (ex 2.2) e finalmente,
uma etapa e edicdo vetorial (ex 2.3).

A. ABRIR E EXPLORAR UM PROJETO ARCMAP | SISTEMAS DE
COORDENADAS

1. Abrir um projeto ArcMap vazio e verificar o sistema de coordenadas.

1.1 Carregar com BLDR sobre a area de visualizagdo » Data Frame
Properties e de seguida carregar na aba Coordinate System. \Verificar o
sistema de coordenadas em que se encontra o projeto no campo Current
Coordinate System (Figura 1).
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Feature Cache Annotation Groups Extent Indicators Frame Size and Postion
General Datz Frame Coordinate System lumination Grids
= ‘ Type here to search v @ ﬂ,l G-
] Favorites|
£ Geographic Coordinate Systems
£ Projected Coordinate Systems
Current coordinate system:

No coordinate system.

Transformations...

Cancelar Aplicar

Figura 1 - Painel de visualizagao do sistema de coordenadas do projeto SIG.

No campo superior desta aba podera explorar os diferentes sistemas de coorde-
nadas disponiveis no ArcGIS, estes encontram-se organizados em dois grandes
grupos: o grupo dos sistemas de coordenadas geograficas e o grupo dos siste-
mas de coordenadas projetadas (também designadas por retangulares) (consul-
tar o Guia Técnico — Sistemas de Informacgao Geografica: Analise Espacial
para informagdo complementar sobre sistemas de referenciagao).

2. Adicionar as camadas de dados “ExtensaoPlataformaContinental.shp”,
“MarTerritorialshp.shp” e “Zona_Economica_Exclusiva.shp” editadas no
ponto anterior.

3. Repetir o ponto 1.1 e verificar o sistema de coordenadas do projeto.

4. Qual o sistema de coordenadas em que se encontra cada uma das cama-
das que adicionou? Podera fazé-lo de varias formas, entre as quais:

4.1 Através do ArcCatalog, BLDR sobre a camada » Properties, na aba
XY Coordinate System.

4.2 No ArcMap, na aba Source da caixa de propriedades (BLDR sobre a
layer » Properties) de cada uma das camadas.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL

25



4.3 No ArcMap, nas propriedades da area de visualizagéo, em Data
Frame Properties, aba Coordinate System e na pasta Layers (Figura 2).

Feature Cache Annotation Groups Extent Indicators Frame Size and Position
General Datz Frame Coordinate System lumination Grids
- ‘ Type here to search v @& ﬂal &~
] Favorites|

(3 Geographic Ceordinate Systems

£ Projected Coordinate Systems

= 2 Layers

= @) GC5_WGS_1984

& LinhaBase
& Zona_Economica_Exclusiva
© MarTerritorial
@ ExtensaoPlataformaContinental

Current coordinate system:

GCS_WGS_1984
WKID: 4326 Authority: EPSG

Angular Unit: Degree (0.0174532925199433)
Prime Meridian: Greenwich (0.0)
Datum: D_WES_1984
Spheroid: WGS_1984
Semima jor Axis: 6378137.0
Semiminor Axis: 6356752.314245179
Inverse Flattening: 298.257223563

Transformations...

Cancelar Aplicar

Figura 2 - Painel de visualizagao do sistema de coordenadas do projeto SIG e das layers que o compde.

B. ADICIONAR INFORMACAQ EM SISTEMAS DE COORDENADAS
DIFERENTES

5. Adicionar os limites administrativos de Portugal (CAOP - Carta Adminis-
trativa Oficial de Portugal) disponibilizados pela Dire¢cao-Geral do Territério
(DGT).

5.1 Adicionar os temas com os limites administrativos de Portugal que se
encontram na pasta do exercicio 2, subpasta — DirecaoGeralTerritorio.

Estas camadas (ou temas) que ira adicionar encontram-se nos sistemas de coor-
denadas:

* Continente — ETRS 1989 Portugal TM06 (datum ETRS 1989; Projecao TM)

* Regiao Autébnoma dos Acores Oriental e Central - PTRA08 UTM Zone 26N
(datum ITRF 1993; Projecao UTM)

* Regiao Auténoma dos Acores Ocidental - PTRA08 UTM Zone 25N (datum
ITRF 1993; Projecédo UTM)

* Regiao Autdbnoma da Madeira - PTRA08 UTM Zone 28N (datum ITRF 1993;
Projecao UTM)
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Todos os temas tém em comum um mesmo datum (ou equivalente).

O projeto ArcMap ao qual esta a adicionar os temas com os limites administra-
tivos esta representado no sistema de coordenadas geograficas - WGS84 (ver
ponto 3). Este sistema tem por base o datum WGS84 que é idéntico ao datum
ETRS89 (e ITRF93) (consultar o Guia Técnico — Sistemas de Informagao Geo-
grafica: Analise Espacial para informagdao complementar).

Neste momento estamos a trabalhar com dados que, embora apresentem proje-
cOes diferentes, estdo num datum equivalente, deste modo a uniformizacao para
um sistema unico ocorre através de uma simples converséo (ou projecao) de
coordenadas.

Num projeto ArcMap, que envolva dados em sistemas de coordenadas diferen-
tes, devera definir os parametros a utilizar para as transformacdes de coordena-
das (quando ha alteragao de datum) selecionando-os de entre a lista de transfor-
macoes disponiveis no software. Para determinados data locais nao existem, no
ArcMap, definidos os parametros de transformacao, nestes casos podera adi-
ciona-los tendo por base as recomendacgdes das instituicbes responsaveis pelo
territorio (em Portugal os parametros sao disponibilizados pela DGT).

5.1.1 Selecionar, para cada um dos temas adicionados, a transforma-
¢ao de coordenadas a aplicar. Devera surgir um alerta de utilizagcédo de
sistemas de coordenadas distintos (Figura 3, esquerda), carregar em
Transformations, no campo Using (choices are sorted by suitabi-
lity for the layer’s extent) (Figura 3, direita) e definir a transformacao
a aplicar.

No caso particular deste exercicio as diferentes camadas encontram-se em
projecoes distintas mas tém em comum um datum equivalente e por isso
as transformacgobes sugeridas (por omissao) constituem parametros a zeros
(Figura 3, direita) ou aparecem com a opg¢ao <none>.

5.1.2 Escolher as transformacdes com parametros a zero para a trans-
formagao entre os data WGS84 e ETR89; e utilizar none para a trans-
formagao entre WGS84 e ITRF93.

Apos a definicdo das transformacgdes a aplicar o ArcMap efetua a transfor-
macao de coordenadas “On the fly”, i.e. procede a projecdo dos dados
num sistema de coordenadas comum sem que haja alteragdo aos dados
originais.
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Em ArcMap a alteracao entre sistemas de coordenadas faz-se via 2
métodos distintos: um modo “On the fly”, i.e. uma conversaol/trans-

formagdo em tempo real sem alterar as propriedades originais dos
dados, ou através da alteragao das caracteristicas posicionais dos

e dados de origem, normalmente através da ferramenta Project.

Ainda, as transformacgoes sao bidirecionais, i.e. a transformacgao
designada em ArcMap por ED_1950_To_WGS_1984 tanto é aplicavel
a transformacgao de coordenadas de ED50 para WGS84 como de

WGS84 para ED50.

The following data sources use a geographic coordinate system that is different from
the one used by the data frame you are adding the data into:

Data Source Geographic Coordinate System
Cont_AAD_CAOP2014 GCS_ETRS_1989

Alignment and accuracy problems may arise unless there is a correct transformation
between geographic coordinate systems.

‘You can use this button to specify or modify the

transformation(s) used by this data frame: TSI

The Transformations diglog can also be accessed from the Data Frame Properties
dialog's Coordinate Systems tab after you have added the data.

["] pon't warn me again in this session
[]Don't warn me again ever

About the geoaraphic coordinate
systems warning

Convert from:

GCS_ETRS 1989

GCS_WG5_1984

Into:
GC5_WGS_1984

Using (choices are sorted by suitability for the layer's extent):
ETRS_1989_To_WGS_1984 v

Method: Position Vector - dx=0.000000 dy=0,000000 dz=0.000000
rx=0.000000 ry=0.000000 rz=0.000000 s=0.000000

About geographic transformations

Figura 3 - Caixa de alerta para dados num sistema de coordenadas diferente (esquerda) e caixa para a definicdo

da transformacéo de coordenadas a utilizar (direita).

shapefile como se explica seguidamente.

C.PROJETARDADOS NUM SISTEMA DE COORDENADAS

6. Criar/projetar novas shapefiles, em coordenadas geograficas WGS84,
com as camadas de dados que nao estao neste sistema de coordenadas
(camadas com limites administrativos).

Até agora as converstes de coordenadas efetuadas foram temporarias (on the fly), uma
vez que nao se alteraram as propriedades dos dados originais. Para alterar as coordena-
das intrinsecamente nos dados devera utilizar a ferramenta Project ou exportar a

6.1 Utilizar a ferramenta Project, em Data management: Tools » Projec-
tions and Transformations (Figura 4). Nomear as novas shapefiles por
forma a reconhecer a alteragao efetuada (e.g. colocar wgs no nome).
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ArcToolbox

= & Data Management Tools
& Archiving
&g Attachments
& Data Comparison
&y Distributed Geodatabase
& Domains
&y Feature Class
&y Features
&y Fields
& File Geodatabase
&g General
% Generalization

Input Dataset or Feature Class Project A

Cont_AAD_CAQP2014 =l &
Input Coordinate System {optional)
ETRS89_Portugal TM06 fier

Projects spatial data from one
coordinate system to another.

Output Dataset or Feature Class
[ B:\S0PHIAWioblo_A Exercoos Exercrio? Dadostx e tadost || 3]

Output Coordinate System

| GCs_wes_1984 |

Geographic Transformation (optional)

INPUT

ETRS_1989_To_WGS5_1984

&y Geodatabase Administration

&y Geometric Network GCS_GRS 1980

e = [x] [+ | ]

& Graph Scale: 116,500,000
% Indexes

&y Joins *

&y LAS Dataset

& Layers and Table Views OUTPUT

&y Package
&y Photos
= & Projections and Transformations
& Raster
& Batch Project
‘\ Convert Coerdinate Notation
“\ Create Custom Geographic Transfon
“\ Create Spatial Reference

P4

NAD_1863_UTM_Zone_22N

%, Define Projection Seale: 1:16,500,000 v
‘\ Project
= B Racter 4 ‘ aK | ‘ Cancel ‘ |Erw|mnmems..‘ | ‘ << Hide Help | ‘ Tool Help
< >

Figura 4 - Ferramenta Project para projetar dados num sistema de coordenadas distinto.

6.2 Em alternativa podera exportar cada camada de dados, adotando

o sistema de coordenadas do “georreferencial’ (ou projeto) durante a
gravagao dos dados (Figura 5). Carregar com BLDR sobre a camada de
dados, depois em Data » Export Data, na caixa de opgdes que surge se-
lecionar a opgao: Use the same coordinate system as: the data frame.

Se optar por esta solugado para a gravagao de dados num sistema de coorde-
nadas diferente devera certificar-se que o seu referencial (data frame) esta no
sistema de coordenadas pretendido.

Table Of Contents " x

Copy Export: |AII features

Remove

Open Attribute Table Use the same coordinate system as:

Joins and Relates » R .

ZoomToLayer () this layer's source data

oo ke s (®) the data frame

Visible Scale Range »

Use Symbol Levels the feature dataset you export the data into
e ) (only applies if you expaort to a feature datasetin a geodatabase)
Label Features Cutput feature dass:

Edit Features »

D:\SOPHIA\Modulo_AE\Erercicios\Exercicio2\DadosEx2\Edtados (|

o Convert Features to Graphics...

i

Convert Symbology to Representation...

Data » epair D Sou
<> SaveAs LayerFile.. < Export Data...
> Create Layer Package... Export Data
[ Properties. Save this layer's data as a shapefile

or geodatabase feature class

[EETER

Figura 5 - Exportar dados utilizando o sistema de coordenadas do projeto.
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7. Remover as camadas de dados CAOP que nao se encontrem em WGS84
e agrupar as camadas de dados em dois grupos: “Aguas Marinhas” e “Lim-
ites Administrativos”:

7.1 Selecionar as camadas de dados relativas as zonas marinhas, carre-
gar como BLDR e fazer group.

7.2 Repetir o procedimento para as camadas de dados com os limites
administrativos e nomear os grupos.

8. Verificar que todas as camadas de dados do seu projeto estao no mesmo
sistema de coordenadas, repetir o ponto 4.3.

Feature Cache Annotation Groups Extent Indicators Frame Size and Position
General Data Frame Coordinate System llumination Grids

R | Type here to search v @ @ | [ErRa: 4

= B Layers
o ) GCS WGS_1984

Y 0P _Cont wssad
© CAOP_AcorGC_wgsed
© CAOP_AcorGOc_wgsed
© CAOP_Mad_wgsB4
© CAOP_AcorGOr_wgsed
€ ExtensaoPlataformaContinental
@“ MarTerriterial

T L Coccliicinin

Current coordinate system:

GC5_WGS_1934
WKID: 4326 Authority: EPSG

Angular Unit: Degree (0,0174532925199433)
Prime Meridian: Greenwich (0.0)
Datum: D_WGS_1984
Sphercid: WG5_1984
Semimajor Axis: 6373137.0
Semiminor Axis: 6356752.314245179
Inverse Flattening: 298.257223563

Transformations. ..

Cancelar Aplicar

Figura 6 - Sistema de coordenadas das camadas de dados do projeto SIG.
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D. CALCULO DE AREAS | PROJECAO DE COORDENADAS

9. Escolher um sistema de coordenadas projetadas que lhe parecer adequa-
do ao calculo de areas e reprojetar os dados “On the Fly”.

(Se necessario, consultar o Guia Técnico — Sistemas de Informagao Geografica para
informac&o complementar sobre sistemas de referenciagéo).

10. Adicionar um campo a cada uma das tabelas de atributos das cama-
das de mar (semelhante ao efetuado no ponto 5 do exercicio 2.1), para
preencher com o calculo de areas em km?.
11. Quais as areas, em km?, respetivas a cada camada de dados? Utilizar o
Calculate Geometry, disponivel ao clicar com o BLDR sobre o campo que
quer preencher.

11.1 Qual a area total de Mar territorial?

11.2 Qual a area total de Zona Econdmica Exclusiva?

11.3 Qual a area total de Extensao da Plataforma Continental?

12. Pesquisar na internet as areas calculadas e dizer quais as razées para
as eventuais diferengas encontradas.

13. Gravar e fechar o projeto.
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Exercicio 2.3 5
PORTUGAL NOMUNDO | EDICAO
VETORIAL

Objetivos

Este exercicio corresponde & continuac3o dos exercicios anteriores (2.1e
2.2) em que o objetivo é determinar a area territorial de Portugal e a area
correspondente as aguas marinhas portuguesas, tendo por base informacao
geografica oficial disponibilizada pela Dire¢do-Geral do Territdrio (DGT) e
pelo Instituto Hidrografico (IH).

Ira realizar uma série de tarefas de edicdo e processamento de forma a sim-
plificar, editar, corrigir e extrair a informacdo pretendida, nomeadamente
gerir e editar informacdo das tabelas de atributos, homogeneizar e agregar
informacdo espacial ndo necessaria, fazer edicdo vetorial, rotular informa-
cdo e calcular areas.

Ainda neste exercicio ird ter acesso a informacao referenciada em sistemas
de coordenadas distintos, pelo que realizara tarefas de transformacao e
projecao de coordenadas.

Este exercicio estd distribuido por trés etapas, uma primeira onde se
introduz a gestdo de campos de tabelas de atributos (ex 2.1), uma etapa que

aborda a problematica dos sistemas de coordenadas (ex 2.2) e finalmente,

uma etapa e edicdo vetorial (ex 2.3).

A. ABRIR E EXPLORAR UM PROJETO ARCMAP | EDICAQ
VETORIAL

1. Abrir o projeto ArcMap que gravou no ponto anterior.

2. Juntar todos as camadas de dados com informagao de aguas marinhas
numa mesma camada de dados e editar a respetiva simbologia em fungao
do seu descritivo:
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2.1 Utilizar a ferramenta Merge (Data Management Tools » General »
Merge). Selecionar as trés camadas que quer agregar no campo Input
Datasets e definir o nome e caminho para a geragdo de uma nova cama-
da de dados em Output Dataset (Figura 1).

ArcToolbox m
Merge
&l ArcToolbox ~ Input Datasets o N
@ 3D Analyst Tools I E=) Combines multiple input datasets of the same
) data type into & single, new output dataset
B3 Analysis Tools This ool can combine point, line, or potygon
&3 Cartography Tools <" mar\ExtensaoPlatsformaContinents| + festirs class s or tables.
. <" marMarTerritorial o
@ Conversion Tools N . Use the Append tocl to combine input
.. < »mar‘Zona_Economica_Exdusiva x datasets with an existing dataset.
B9 Data Interoperability Tools
= B9 Data Management Tools +
. INPUTS
& Archiving N —
s
% Attachments |
% Data Comparison
% Distributed Geodatabase

Output Dataset
compositoDadosEdits\AguasMArinhas_PT.shp E}
Field Map {optional)

%5 Domains
% Feature Class
%5 Features

& Fields e rext) +
[+ Descritivo (Tex
%; File Geodatabase -Iat(Text} =
= & General #l-long (Text)
x\ Append NATION (Text)
“\ Calculate Value
“ Copy
“\ Create Database View
“\ Delete N .
“\ Delete |dentical < >
#, Find Identical
P Cancel Environments. .. << Hide Help Tool Help

S Y,

Figura 1 - Ferramenta para agregar diferentes camadas — Merge.

Neste momento devera ter uma camada Unica em que as areas marinhas de
Portugal estao representada nas entradas da respetiva tabela de atributos
(Figura 2). Para simplificar a visualizagéo e o processamento do projeto SIG, e
uma vez que nao serao mais necessarias, podera remover as camadas iniciais/
originais.

2.2 Editar a Simbologia da shapefile em fungdo da sua origem utilizando
as seguintes cores, sem contorno:

e Mar Territorial - SODALITE BLUE
e Zona Econdmica Exclusiva — BIG SKY BLUE
¢ Extensdo da Plataforma Continental — DELFT BLUE
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Nos casos em que a simbologia de uma camada é muito detalhada e
envolve muitos procedimentos, e.g. quando contém muitas catego-
rias de dados, esta pode ser gravada num ficheiro “.lyr” e posterior-
mente replicada.

9 Para gravar a simbologia gerada carregar com o BLDR sobre a cama-
da (com a simbologia ja editada) e fazer Save as Layer File.

Quando quiser replicar a simbologia gravada para uma outra ca-
mada, ou projeto SIG, devera importar o ficheiro “.lyr” na respetiva
caixa de edicao de simbologia.

2.3 Gravar um ficheiro que contenha a informacéo sobre a simbologia
que utilizou. Carregar com BLDR sobre a camada aguas marinhas e fazer
Save as Layer File.

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
NeEs& Bx|o & - |[125000000 MiFEHl=1=1=1-]al Ea 1= Rk H 1§ 2 =
IR TR R B =IY el
Editor ~ - b= o B
50 E [ @B B
Table Of Contents 2 x
a¢8 g z
1 Layers Table o x o

£ @ LinhaBase

ERE-ML=LY
AguasMarinhasPT =
] aTion |

[ B AguasMarinhasPT
Origem
I Extenséo da Plataforma Continental

=]

FID | shape | id Origem
0 [ Polygan enséo da Plataforma Continental

1| Folygen
2| Polygon
3 | Polygon
+Polygon
5 | Polygon
6
7
8
s

Folygon

Polygon
Polygon
Polygon

§|3|3 3 3|3|3/3|3)|3

ot 0+ 1 BB 0outof 10Selected)

| AguasMarinhasPT |

CIEYERR
Drawing= K (=) %3 | ]~ A = |0) Aial vt viB T U A-d - 2. ..

I

2°29'35.433"W 52°27'36.435°'N

Figura 2 - Camada de dados resultante da agregacao dos trés poligonos com areas marinhas Portuguesas.

2.4 Ver a tabela de atributos da nova camada de dados e preencher a
informagao em falta utilizando a acao Field Calculator.

2.5 Produzir uma nova camada de dados que contenha as areas marinhas
de Portugal representadas por um poligono para cada origem (Descritivo)
de dados. Esta acéo efetua-se através da ferramenta Dissolve do Arc-
Toolbox (em Data Management Tools » Generalization) (Figura 3).
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Esta acao permite “dissolver” informacgao tendo por base caracteristicas comuns
de uma tabela de atributos.

2.5.1 Criar uma nova camada de dados aplicando a ferramenta Dis-
solve com o atributo NATION em Dissolve_Field(s) Optional.

2.5.2 Repetir o passo anterior, neste caso, utilizando o atributo Descri-

tivo em Dissolve_Field(s) Optional. Verificar as diferencas entre as
duas camadas resultantes.

Note que ao aplicar esta agcdo muita da informacéao parcial contida na tabela
de atributos perde-se, ou “dissolve-se” numa informacgéo Unica para toda a
extensao espacial representada. Ainda, se nao selecionar nenhum atributo
no campo Dissolve_Field(s) Optional, a camada resultante uniformiza toda

a area num so registo (neste caso seria o equivalente ao efetuado o ponto
anterior).

ArcToolbox
[l ArcToolbox ~ Input Features ~ | Dissolve ~
&9 30 Analyst Tools [ AguasMarinhas PT R =]

& Analysis Tools Agoregates features based on
]

Output Feature Class specfiied attributes

&3 Cartography Tools C:\Users\Aninha\Documents \ArcGIS \Default.gdb \AguasMarinhas| |2

@ Conversion Tools Dissolve_Field(s) (optional)

Q Data Interoperability Tools [IFp INPUT
=] & Data Management Tools O
L Desdritivo
&y Archiving st
& Attachments [ teng
& Data Comparison [ naTION

& Distributed Geodatabase
&y Domains
& Feature Class

Feat
& Feal dure; Select Al Unselect All Add Field *
% eles Statistics Field{s) (optional)
& File Geodatabase
& General
= B Generalization Field Statistic Type

"\ Dissolve

#, Elimi

%, Eliminate

ouTPUT

"\ Eliminate Polygen Part
% Geodatabase Administration
& Geometric Network v v
& Graph

& Indexes oK Cancel Environments... << Hide Help Tool Help
v
— W oo

= = x 4|,

Figura 3 - Ferramenta para “dissolver” diferentes registos — Dissolve.

3. Editar a simbologia da camada de dados, dissolvida por “Descritivo”, com a
mesma paleta de cores utilizada anteriormente. Importar a simbologia aplicada

na camada de dados anterior.

3.1 No campo de edi¢cao da simbologia da camada, fazer import, carregar
no simbolo [ e navegar até a pasta onde gravou o ficheiro “.lyr". Selecio-
na-lo e fazer OK, confirmar o campo para a descriminacéo da cor e fazer

OK.
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3.2 Caso a camada com a simbologia correta ainda esteja na tabela de
conteudos, podera importar a simbologia diretamente, através de import e
selecionando a camada de dados cuja simbologia quer reproduzir.

3.3 Remover as camadas e dados que originaram a camada simplificada e
remover a camada dissolvida pelo campo NATION.

4. Juntar as areas administrativas das regioes portuguesas numa unica
camada de dados.

4.1 Qual a ferramenta de processamento mais adequada e porqué?

5. Simplificar as areas respetivas aos limites administrativos por forma a re-
presentar em apenas um poligono as regioes administrativas portuguesas.

5.1 Qual a ferramenta de processamento mais adequada e porqué?

Como a informagéo adicional referente aos limites administrativos a nivel local nao é
necessaria (no ambito deste exercicio) a acdo de dissolugdo, embora desaproveite muita
informacao, ira simplificar a representacao e otimizar a visualizagdo/processamento do
seu projeto.

B.EDICAO VETORIAL EMMODO DE EDICAQ

Neste ponto ird proceder a algumas tarefas de edi¢ao vetorial essencialmente relaciona-
da com a geometria dos objetos.

Podera verificar que existem lacunas' de representacao entre o Mar Territorial e a porgcéo
terrestre de Portugal (Figura 4). Para corrigir estes espacgos vazios ira criar e editar uma
nova shapefile vetorial do tipo Polygon onde ira desenhar os espagos vazios.

' Estas lacunas correspondem as aguas interiores que estao definidas oficialmente e podem ser encontradas na internet.
No entanto, para fins deste exercicio iremos assumir que esta informagéo ndo nos € disponibilizada.
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File Edit View Bookmarks |nsert Selection Geoprocessing Customize Windows Help
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Table Of Contents "x L
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Figura 4 - Camadas de dados simplificados dos limites administrativos de Portugal e aguas marinhas portuguesas.

A edicao vetorial tem por base a barra de ferramentas Editor

Editar ~ ’“ T I:;U: Elj - E’

Para comecar a editar as camadas de dados vetoriais devera acionar o modo de edi¢ao
em Editor » Start Editing. Quando terminar a edigdo devera fazer Editor ™ Save Edits
e fechar o modo de edigdo em Editor» Stop Editing.

6. Criar uma shapefile nova do tipo Polygon, para representar as areas entre
as duas camadas de dados existentes.

6.1 A criagao de uma shapefile vazia podera ser efetuada através da
ferramenta do Data management Tools ™ Feature Class, Create Fea-
ture Class (Figura 5).

6.1.1 Preencher os diferentes campos solicitado, sendo que no
campo Template Feature Class (optional) podera selecionar uma
camada de dados que servira como padrao no que diz respeito
aos atributos a incluir nesta nova shapefile.

6.1.2 Utilizar o sistema de coordenadas geograficas baseadas no
datum WGS84.
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Em alternativa, podera criar a shapefile através do ArcCatalog. Navegar até a

pasta de dados deste exercicio, carregar com o BLDR sobre o display PNew »

Shapefile. Devera definir o tipo de vetor (poligonos, linhas ou pontos) e o siste-

ma de coordenadas da nova shapefile (Figura 6).

ArcToolbox

Bl ArcToolbox

B 20 Analyst Tools
e Analysis Tools

° Cartography Tools
@ Conversion Tools

Feature Class Location

D:\SOPHIAModulo_AE \Exerdicios\Exerdicio?\DadosEdits
Feature Class Name

lacunas

Geometry Type (optional)
POLYGON

<

Create Feature Class

Creates an empty feature class in an
ArcSDE. file geodatabase, or
personal geodatabase; in a folder it
creates a shapefile.

e Data Interoperability Tools ]
= e Data Management Tools I =]
& Archiving
& Attachments
& Data Comparison
&y Distributed Geodatabase
& Domains
=) & Feature Class
K\ Append Annotation Feature Classes
#, Calculate Default Spatial Grid Index
ar\ Calculate Default XY Tolerance Has M (optional)
BN G Fetre ] o .
#, Create Fishnet Has Z (optional)
x\ Create Random Points DISABLED v

<> AguasMarinhasPT

- = x| 4 B

Coordinate System (optional)

P h
%, Create Unregistered Feature Class acs was_1384 [

., Integrate
x\ Update Annotation Feature Class
& Features

¥ Geodatabase Settings (optional)

& Fields

& File Geodatabase Cancel Environments... << Hide Help Tool Help
v

P S

Figura 5 - Caixa Create Feature Class, uma ferramenta da toolset. Data Management Tools para gerar uma
shapefile vazia.

< =
File Edit View Go Geeproces:
LB AR x

Customize Windows  Help

BQBEEE D e g

DASO ¥ DadosEdts v
=
Contents | Preview | Description
Name Type
[E)Zona_Ecenomica Exclusiva.shp Shapefile
[E)New_Shapefile.shp Shapefile
[EMarTeritorial.shp. Shapefile
[=LinhaBase.shp Shapefile
([@lacunas.shp Shapefile
[EExtensaoPlataformaContinental.shp Shapefile B Copy CtrieC
[0 Cont_AAD_CAOP2014_d.shp Shapefile
[E)CAOP_WGSB4.shp Shapefile % Delete
[E)CAOP testeshp Shapefile
Rename  F2
[E)CAOP_ITRFS3.shp Shapefile
[ ArqMadeira_AAd_CAOP2014_d.shp Shapefile | = FRefrsh  F5 | Folder
[E)ArgAcores_GOrientaLAA_CAOP2D14_d.shp Shapefile | New v |3 File Geodatabase
[E ArgAcores_GOcidental AAd_CAOP2014_d.shp Shapefile | ¢ properties. (3 Personal Geodatabase
(& ArgAcores_GCentral AAd_CAOP2014_d.shp Shapefile 3 Database Connection...
(E) AguasMarinhasPT_d0.shp Shapefile i AreGIS Server Connection...
(E) AguasMarinhasPT_dN.shp Shapefile p
<> AguasMarinhasPT.lyr Layer @ Layer.
(E)AguasMarinhasPT.shp. Shapefile €7 Group Layer
B Python Toolbox
[ Shapefile.
=) Tum Feature Class. New Shapefile
@ Toolbox Crestes a new shapefile
dBASE Table
[E]  LAS Dataset
&  AddressLocator..
& Composite Address Locator...
Folder selected B KL Bocument

Figura 6 - Criar uma shapefile vazia através do ArcCatalog.

7. Iniciar a edigdo do poligono adicionado e desenhar poligonos que preen-
cham as lacunas espaciais do mar territorial.

7.1 No caso da nova camada de dados nao ter sido automaticamente adi-
cionada ao projeto: adicionar a camada e iniciar o modo de edi¢ao vetorial
(Figura 7).
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7.2 Desenhar um poligono, com contornos aproxi-
mados?, de uma das lacunas existentes:

7.2.1 Na caixa Create Features, carregar na
camada a editar, depois em Polygon e comegar
a desenhar a forma carregando sobre o dese-
nho, fazer duplo clique para finalizar o poligono
(Figura 8, esquerda).
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Editor-| » oLl : [ BB A N ,
= = layers
< Start Editing | = O LinhsBase
Stop Editing =] 2 cunasy
) Start Editing o B copy
& SaveEdits . . = B CAop{ X Remove
Start an edit session so you can - B Open Atribute Tabl
Move... edit features or attributes, pen Aiiihwie Tavle
5 M Aguas Joins and Relates »
Split... -
L ‘ & Press F1 for more help. O NewGr & Zoom To Layer
t Construct Points... Zoom To Make Visible
+ CopyParallel... Visible Scale Range 3
Use Symbol Levels
Merge...
- Selection 3
# Buffer.. Label Features
Unien... Edit Features v [ Start Editing
Clip Convert Labels to Annotation...
o
L T
1, Validate Features < Organize Featy g+ an edit session on the
Convert Symbology to Representation... i s T
. For example, if you right-click a
Dat » ple. if yourigl
Snapping » ot eI
Save As Layer File. editing it, you are able to edit all
More Editing Tools — » & Creste Layer Package. the other layers from that same
i ok geodatabase.
Editing Windows 3 Properties...

[T

Options... Drawing = K () %] | O - A - < [[[g] aral v

Figura 7 - Modos para iniciar o modo de edi¢gdo de uma camada de dados vetorial.

7.2.2 Escrever um descritivo relativo ao poligono que desenhou na
respetiva entrada da tabela de atributos. Carregar no simbolo e
acrecentar uma descrigao (e.g. localidade préxima) ao campo Descriti-
vo (Figura 8, direita).

2 No ambito deste exercicio ndo dé importancia a precisdo com que contorna as lacunas, particularmente no que diz res-
peito ao limite adjacente a camada CAOP, uma vez que esta apresenta uma definicdo extremamente rendilhada e dificil
de reproduzir através desta edigao simples.
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If?(:rea l Edit Sketch Pru:-perties‘ Null values not allowed

Figura 8 - Caixas comuns na edi¢do de vetores, a esquerda caixa para a geragao da forma geogréfica e a
direita o registo da respetiva informagéo na tabela de atributos.

7.3 Repetir este procedimento (ponto 7.2) para mais uma(s) lacuna(s) a
sua escolha explorando em simultaneo as diferentes ferramentas disponi-
veis na barra de ferramentas Editor, nomeadamente a edigdo de vértices.

7.4 Desenhar, para cada uma das restantes lacunas, poligonos alargados
que incluam toda a extensao das lacunas, sem se preocupar com 0s con-
tornos proximos das restantes camadas de dados (tomar como exemplo
a Figura 9). Gravar as edic¢oes e feche o modo de edi¢éo (Editor ™ Save »
Edits e Editor » Stop Editing).
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Figura 9 - Exemplo de criagéo de poligonos em torno das lacunas espaciais entre CAOP e Aguas Marinhas.

Uma carateristica muito comum em ArcMap é a existéncia de varios

procedimentos (ou aplicagdo de sequéncias de ferramentas dis-
9 tintas) para se atingir o mesmo objetivo.

Esta caracteristica é particularmente percetivel na edicao e analise

de dados.

8. Operagoes de edigao — Erase

Para redefinir a forma dos poligonos alargados em fungéo de limites de outras cama-
das de dados (neste caso CAOP e Aguas Marinhas) podera utilizar a ferramenta Erase

incluida no grupo de funcional Analysis Tools » Overlay (Figura 10).

8.1 Aplicar a ferramenta Erase até obter uma camada que contenha ape-
nas as lacunas entre as camadas de dados CAOP e Aguas Marinhas.
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‘\ Unicn
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%: Statistics
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@ Geostatistical Analyst Tools
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% Input Features

I El=)
% Erase Features
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% Output Feature Class

Dedmal degrees v

XY Tolerance (optional)

oK Cancel Environments... << Hide Help

Creates afeature class by overlaying
the Input Features with the poly gons of
the Erase Features. Only those
portions of the input features falling
outside the erase features outside
boundaries are copied to the output
feature class.

INPUT

e

ERASE FEATURE

..

OuTPUT

[

Tool Help

v

Figura 10 - Ferramenta Erase incluida na toolset Analysis Tools.

9. Operagoes de edigao — Union e Merge em modo de

edicao.

9.1 Juntar a camada de dados com o preenchimen-
to das lacunas ao poligono que representa o “Mar
Territorial” da camada de dados “Aguas Marinhas”
utilizando o Union da barra de ferramentas Editor.

Com o projeto ArcMap em modo de edi¢ao, podera efetuar algu-

mas operacoes de edicao de forma imediata. Por exemplo, se

tiver os registos de dados “Mar Territorial” e “lacunas” seleciona-

dos podera uni-los (com o Union).

Podera fazer a selegao espacialmente ou através das respeti-

vas tabelas de atributos. Devera utilizar como template o registo

“Mar Territorial”, assim a nova entrada na camada de dados ja

estara corretamente classificada e representada.

Editor || » |

"7 Stop Editing
B‘ Save Edits

Move...

Merge...
& Buffer...

Union...

Snapping
Meare Editing Tools
Editing Windows

Options...

3

3

»
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Table - lacunas_e2
(-1 RO
lacunas_e2 X AguasMarinhasPT_dO

FID |_Shape * | Origem FID | Shape * Origyeenm

[0 Polygon_[Espinno 0 |Polygon | Extenséo da Plataforma Continental
Polygon | Peniche: +| 1] Polygon | MarTerrtorial

Palygon 2 [Polyoon | Zona E

Choose a template to create feature(s) with:

NENE

Polygon B E . .
Foygon | Template... | .Mar Territorial

oA e

/(5 out of 5 Selected) Tl
flacunas &7

FR] E (1 out of 3 Selected)

| AguasMarinhasPT_do |

QK

Figura 11 - Processo para a unido de registos através do Union em modo de edigdo (a esquerda, selecédo de
registos nas respetivas tabelas de atributos e definicdo do template para o novo registo unido).

9.2 Utilizar a ferramenta Merge em modo de edigao para juntar os regis-
tos correspondentes ao “Mar Territorial” da tabela de atributos das aguas

marinhas portuguesas.

Selecionar os registos que quer juntar e de seguida fazer Editor » Merge.

9.3 Gravar as edi¢des, fechar o editor e remover as camadas de dados

que serviram de apoio a edi¢ao efetuada.

10. Criar uma shapefile de pontos a semelhanc¢a do que fez no ponto 6, com
o nome “localizacao” e marcar 1 ponto em cada grupo de ilhas (3 nos Acgo-
res e 1 na Madeira) e 1 ponto no centro geométrico de Portugal.

10.1 Criar a shapefile de pontos vazia e se necessario adicionar ao proje-

to.

10.2 Adicionar um campo de texto, com o nome “Descritivo”, a tabela de

atributos onde ira escrever a descrigao geografica de cada um dos pontos.

0 Para criar ou apagar campos numa tabela de atributos devera ter o

modo de edigao fechado.

10.3 Iniciar o modo de edi¢ao desta camada de
dados.

10.4 No separador Create Feature ativar a camada
de dados localizagao e depois carregar em Point
para comecar a desenhar pontos:

Create Features

=
B~ B <Search>

AguasMarinhasPT_d
|| aquasMarinhasPT_d
CADP_WGS84_d
[ cror_wesa4 d

localizacao

@ localizacao!

EM

[ Construction Tools

[57 Paint

" Point at end of line

Edit Sketch Properties

£ Ereate Featires
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10.4.1 Marcar um ponto aproximadamente no centro do Arquipélago
da Madeira e escrever “Arquipélago da Madeira” no campo “Descritivo”
da tabela de atributos.

10.4.2 Repetir este procedimento para o Arquipélago dos Agores, nes-
te caso adicionar um ponto para cada um dos grupos: "Agores grupo

ocidental”, “Agores grupo central” e “Acgores grupo oriental”.

10.4.3 Colocar um ponto no centro geografico de Portugal mas neste
caso utilizando a sua localizagao precisa Lat: N 39°41’ e long: W 8°7".
Criar um ponto em qualquer local do display e de seguida carregar

com o BLDR, selecione Absolute X,Y e coloque as coordenadas pre-
tendidas. Coloque a descri¢cao “Portugal continental” no ponto criado.

10.5 Verificar na tabela de atributos se tem 5 pontos, gravar as edigdes
efetuadas e fechar o modo de edigao.

C.ROTULOS DE DADOS (LABELS)

11. Colocar rétulos (/labels) em cada um dos pontos com a informagao que
esta no campo “Descritivo”.

11.1 Com o BLDR sobre a camada “localizacao” ativar a opcao Label Features
que aciona a visualizagao dos rétulos (Figura 12, esquerda), ou selecionar a cai-
xa Label features in this layer do separador Labels na caixa de propriedades
da respetiva camada de dados (Figura 12, direita).

11.2 Selecionar o campo descrigdo como informacao a mostrar em Label Field
no separador Labels da caixa de propriedades da camada de dados (Figura 12,
direita).

Nesta caixa podera ainda customizar os rétulos de dados, editando a sua simbo-
logia, bem como definir a posicdo do texto relativamente ao ponto marcado no
mapa.
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File Edit View Bookmarks Insert Selection Geoproces

DR & L 58 x|o & 1250000 | |Genersl | Source | Selection | Display | Symbology | Fields | Definiton Guery | Labels | Joins & Relates | Time | HTML Popup |
KAVl e @O mo [¥] Label features in this layer
g ER R e .
EREIEICES BAEEETY |- [Label althe features the same way v]
ents *x
Layers | All features will be labeled using the options specified.
o u
5 ‘CA % RCOW Text String
oW Ag B Open Attribute Table
= Joins and Relates » Text Symbl
> ZoomToLayer |@ Pzl v”g .,|
% Zoom To Make Visible AsBbYyZz
Visible Scale Range , El B 7 U Symbol
e e Other Options Pre-defined Label Style
Selection 3
Label Features Placemert Properties. | ‘ Scale Range | | Label Styles. |
Ed| Label Features D
% €9 Label the layers festures
g oo
Convert Symbology to Representation.
Data »
< Save As LayerFile...
i’ Create Layer Package...
B roperes 0k | | Cancslr || hpicar

Figura 12 - Insercéo de rétulos de dados e respetiva customizacao.

12. Colocar rétulos (/labels) com a informagao sobre a camada “Aguas
Marinhas” (Figura 13). Explorar as opgoes disponiveis no separador Labels.

Extensao da Plataforma Continental

Zona Economica Exclusiva

irtugal continental

Figura 13 - Exemplo de representagéo com rétulos de dados.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL

46



D. CALCULO DE COORDENADAS - (OPCIONAL)

O ArcMap permite efetuar o calculo das coordenadas dos diferentes dados espa-
ciais representados.

13. Calcular as coordenadas dos pontos referentes as localizagoes que
adicionou.

13.1 Adicionar 2 campos na tabela de atributos da camada de pontos, um
onde se ira calcular a latitude e outro a longitude.

13.2 Calcular as coordenadas Lat. e Long. através da opgao Calculate
Geometry da respetiva tabela de atributos.

Note que dependendo do tipo de campo que escolher (texto ou numérico) tera
opgodes diferentes para a descricdo de coordenadas. Ainda, estes campos nao
sao dinamicos pelo que se editar esta camada de dados, alterando as posi¢des
dos pontos, a informagao destes campos nao ¢é atualizada. Devera nestas cir-
cunstancia voltar a efetuar o calculo das coordenadas.

E. CALCULO DE AREAS - (OPCIONAL)

Neste passo pretende-se calcular a area associada a por¢gao maritima e terrestre de
Portugal.

Para atingir este objetivo torna-se necessario converter o sistema de coordenadas que
estamos a usar de um sistema geografico para um sistema de coordenadas projetado.
Como o principal objetivo € o calculo de areas, a selegdo de uma projecao conservativa
desta propriedade é fundamental (ver o Guia Técnico — Sistemas de Informagao Geogra-
fica para informagéo complementar sobre sistemas de referenciagao e projegdes carto-
graficas).

As recomendacdes da Comissao Europeia, através da diretiva INSPIRE, estabelecem o
uso da projecao Azimutal de Lambert de areas iguais (LAEA — Lambert azimuthal
equal-area) para a realizacao de analises estatisticas e visualizagédo. A sua natureza
conservativa de areas faz com que seja a proje¢cao mais adequada para a realizagao de
analises que envolvam quantificacdes de distancias e areas.
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14. Adicionar um campo numérico designado por “area” as camadas de
dados com informagao de Portugal terrestre e aguas marinhas.

15. Projetar o mapa utilizando uma projecao do tipo LAEA.

15.1 Adicionar um campo numérico designado por “area” as camadas de dados
com informacgao de Portugal terrestre e aguas marinhas.

15.2 Nas propriedades do Data Frame selecionar o separador Coordinate Sys-
tem e fazer uma pesquisa de sistemas de coordenadas por “LAEA” Figura 14).

15.3 Escolher a projecao “PTRAO8 LAEA Europe” por ser a recomendada pela
diretiva INSPIRES? para esta regido geografica.

16. Quais as areas de mar e terra, em km?, de Portugal?

Feature Cache Annotation Groups Bxtent Indicators Frame Size and Posttion
General Data Frame Coordinate System lumination Grids
Ty v | |LeEa v @t
11 of 5472 items shown
[ 2 Projected Coordinate Systems ~
= [E7 Continental
=l £ Europe

€3 ETRS 1928 LAEA
= [ National Grids
= £ Europe
€7 1SN 2004 LAEA Europe
Q PTRADS LAEA Europe

Current coordinate system:

PTRADB_LAEA_Furope ~
WKID: 5633 Authority: EPSG

Projection: Lambert_Azimuthal_Equal_Area
False_Easting: 4321000.0

False_Morthing: 3210000.0
Central_Meridian: 10.0

Latitude_OF Origin: 52.0

Linear Unit: Meter {(1.0)

Geographic Coordinate System: GCS_PTRADS w

Transformations. ..

Cancelar Aplicar

Figura 14 - Definigdo de um sistema de coordenadas projetado, conservativo da propriedade area (LAEA).

16.1 Podera ver as estatisticas associadas as areas calculadas (nomea-
damente o somatorio) em Statistics na tabela de atributos (Figura 15).

3 Caso esteja a trabalhar apenas na regiédo continental de Portugal devera escolher a projegao “ETRS 1989 LAEA” uma
vez que esta dentro da area de competéncia do datum europeu ETRS89. Fora da area do ETRS89 recomenda-se a
utilizagédo do datum ITRF (que constitui o datum de referéncia do PTRA08).
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Table 0 x

ERE L1 T

AguasMarinhasPT_dO x
FID Shape * Origem area
0 | Polygon Extensdo da Plataforma Continental 2120852 87471
1 | Pohlygon Mar Territorial §5017.819802
2 | Polygon Zona Econdmica Exclusiva 16500966.58368

Frequency Distribution

Statistics:

Count: 3

Minimum: 65017.815802
Maximum: 2120952 87471

Sum: 3836937.278152

Mean:  1278579.092731
Standard Dewiation: 879582.574319
MNulls: 0

65017.8 1391544.5

Figura 15 - Estatisticas associadas as areas calculadas na camada de dados das aguas marinhas portuguesas.
16.2 Ver a relagéo entre a area terrestre e maritima de Portugal.

17. Adicionar a shapefile “World_EEZ_v8_2014_HR_edit” da pasta de dados
do exercicio 2. Explorar a “importancia” geografica da Zona Econémica
Exclusiva de Portugal na Europa e no mundo (Figura 16).

.
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
D2ds Bxlo b - |[141271 028 vmﬁm P
Blam@ e E-9 8@ LINHLTIRE
& g R B [ IRIEETY - Editor~| » *
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" 4

Georeferencing

Table Of Contents g
EEELIE
= = layers

= @ localizacao

*

& v T
.

=] AguasMarinhas_PT_dDesc
[ <all other values>

Descritivo
[ Mar Territorial
I Zona Econémica Exclusiva
M Extenso da Plataforma Continental
= @ World_EEZ_v8_2014_HR _edit
[}

sinsey B | [seimead eieaio B| [uoiees ol [comea & | [woaicero @l |

EEIERR
Drawing= K (=) #5 [ [~ A - ) Aral

v v B I UA-»-2. .

-27.854 61.873 Decimal Degrees

Figura 16 - Portugal na Europa e no Mundo.
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Exercicio 3
AREAS MARINHAS PROTEGIDAS

Objectivos

Este exercicio agrupa uma grande variedade de funcionalidades do ArcMap
utilizando como tema as Areas Marinhas Protegidas de Portugal (AMPs) e a

sua area envolvente.

Ira descarregar informacdo espacial disponibilizada na internet em diversos
formatos e sitios. Pretende-se, com este exercicio, efetuar uma série de
procedimentos espaciais de selecdo e filtro dos dados com interesse no
modelo de dados vetorial, e de seguida efetuar analise em modelo de dados
matricial, e.g. calculo de volumes, geracao de mapas de declives.

A. ABRIRE ADICIONAR CAMADAS DE DADOS

1. Abrir um projeto ArcMap vazio e adicionar as shapefiles que representam
as Areas Marinhas Protegidas (AMPs) de Portugal.

1.1 Antes de adicionar as camadas de dados, definir o sistema de coor-
denadas de referéncia para o seu projeto (On the fly i.e. sem alterar as
coordenadas dos dados originais). Utilizar o datum PTRAQ08' sem proje-
¢ao (utilize a fungcado Search ‘& para encontrar rapidamente este datum).

1.2 Adicionar os varios poligonos que se encontram na pasta AMPs locali-
zada na pasta de dados do exercicio 3.

1.3 Definir as transformagdes de coordenadas a aplicar pelo ArcMap, as
diferentes camadas de dados, sabendo que os data ETRS89, WGS84 e
ITRF93 sao virtualmente idénticos (ndo necessitam de transformagéao, ou
podem apresentar parametros de transformagao nulos).

' Recomendado pela diretiva INSPIRE e DGT, para mais informagdes consulte o Guia Técnico — Sistemas de Infor-
macgao Geografica: Analise Espacial).
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1.4 Para a transformacao entre o datum local (datum Porto Santo) e o
PTRAOS8 escolher a transformacao que lhe paregca mais correta.

1.5 Simplificar a visualizagao da tabela de conteudos, através da opgao
Collapse All Layers e agrupando todas as camadas num grupo.

1.5.1 Com o BLDR carregar sobre Layers » Collapse All Layers.

1.5.2 Selecionar as camadas de dados, carregar com o BLDR P
Group. Nomear o grupo de camadas como AMPs.

2. Adicionar a camada de dados que contém as areas marinhas portugue-
sas finalizada no exercicio anterior e editar a sua simbologia (dados na
pasta do exercicio).

2.1 Alterar a simbologia importando a simbologia previamente gravada
num ficheiro .lyr.

B. DESCARREGAR E IMPORTAR DADOS COM DIFERENTES
ORIGENS/FORMATOS

Neste ponto ird descarregar dados espaciais referentes a estruturas submarinas a nivel
global e do Oceano Atlantico. A disponibilizagdo de dados espaciais ocorre muitas vezes
em formatos distintos (nem sempre em formatos diretamente importaveis para o ArcMap)
e encontra-se muitas vezes dispersa na internet. Aqui apresentam-se exemplos de sitios
de internet onde podera descarregar informacgao geografica dos oceanos. Ira ainda sele-
cionar e filtrar os dados por caracteristicas espaciais e por atributos.

3. Navegar até ao sitio da internet SEEF - Seamounts Ecosystem Evaluation
Framework (http://www.seamounteef.org/seamounts) e descarregar infor-
macao acerca dos montes submarinos.

3.1 Copiar o ficheiro descarregado para a sua pasta de dados.

O ficheiro descarregado (SEEF_V3.1.accdb) corresponde a um ficheiro Microsoft
Access, base de dados que nao é diretamente importavel para o ArcMap. No en-
tanto, o ArcMap consegue importar ficheiros Access gravados em versées mais
antigas (2000 ou 2002-2003) cuja extensao € “.mdb”.
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3.2 Abrir a base de dados Microsoft Access e grava-la num formato mais
antigo com extensao “.mdb” (em Guardar como). Ainda em Access podera
explorar a informacéo contida nas tabelas de dados.

3.3 Qual das tabelas de dados contém informagao com atributos de natu-
reza geografica?

4. Adicionar a tabela da base de dados “.mdb”, que contém atributos geo-
graficos, ao seu projeto ArcMap:

4.1 Adicionar a tabela através do Add Data ou arrastando diretamente a
tabela do ArcCatalog para o seu georreferencial.

No separador List by Source da tabela de contetdos do projeto surge uma
tabela de dados associada a base de dados. Para representar geograficamente
as diferentes entradas de dados devera definir os campos onde estdo as coorde-
nadas x e y dos dados.

4.2 Com o BLDR sobre a tabela de dados fazer Display XY data (Figura
1) e selecionar os campos da tabela respetivos as coordenadas X e Y.
Devera ainda identificar o sistema de coordenadas em que se encontram
os dados que esta a adicionar (WGS84).

Table Of Contents O x

T U & |4
= = Layers
B3 DASOPHIAModulo AE\Exercicios\Exercicio¥\Dados
£ DASOPHIAModulo_AB\Exercicios\Exerciciod\Dadost AMPs_dgrm
= L DASOPHIA\Module AE\Exercicios\Exercicio¥\dades_edits\SEEF V3.1.mdb

S scomoun
=

Open

Joins and Relates »
X Remove

Data 3
Edit Features »

Geocode Addresses..,

Display Route Events..,
Display X¥ Data... |

-+

t 9

-

o+
oy

&

Properties...

| Display XY Data

Adds a new map layer based on
A events from a table,

Figura 1 - Definigdo dos campos da tabela de dados que contém a designacéo das coordenadas X e Y.
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ApOs este passo, os pontos associados as posi¢cdes de cada um dos montes submari-
nos ja se encontram representados no projeto. No entanto estes pontos séo temporarios
(“Events”) pelo que deverdo ser convertidos numa shapefile de dados permanente.

4.3 Converter o ficheiro de dados temporario “SeamountList Events” numa
shapefile, carregando com BLDR e fazendo Data ™ Export Data. Gravar
na pasta de dados deste exercicio, nomear a shapefile “Seef Seamouts” e
adicionar ao projeto. Remover os ficheiros temporarios.

A adicao de informagao espacial gravada numa folha Excel, a um
projeto ArcMap, segue os mesmos procedimentos descritos para a
adicao de uma tabela Access:

» Adicionar a folha/tabela com os dados espaciais e com a infor-
macao das coordenadas X,Y

9 * Fazer Display XY Data
* Exportar o ficheiro temporario para uma shapefile.

Nota: O ArcMap 10.2.2 e versdes anteriores ndao sao compativeis com
os ficheiros Excel em “.xIsx”, pelo que devera gravar os dados numa
versao de Excel mais antiga (em “.xIs” p.ex.).

5. Adicionar um mapa de base para perceber a distribuicao geografica dos
montes submarinos que adicionou.

5.1 Adicionar um mapa de base (Basemap) disponibilizado pela ESRI on-
line. Carregar na seta imediatamente ao lado do botdo Add Data e fazer
Add Basemap (ou carregar File ™ Add Data» Add Basemap). Escolher
um mapa de base que lhe pareca adequado.

6. Navegar até ao sitio da internet GEBCO - General Batymetric Chart of the
Oceans (http://lwww.gebco.net/) e explorar a informagao que disponibilizam
sobre os oceanos e sobre as estruturas submarinas.

Pretende-se descarregar deste sitio de internet as descrigdes e localizagbes das estrutu-
ras submarinas e a batimetria dos fundos submarinos para a regido de aguas marinhas
portuguesas, com uma resolucédo de malha de 30 arco-segundos.
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7. Descarregar, do sitio GEBCO, a informacgao sobre as estruturas submari-
nas, em shapefile, e a batimetria dos fundos na area geografica entre 42°W
e 7°W; e entre 28°N e 49°N em formato ESRI ASCII 2. Guardar os ficheiros
descarregados numa pasta \GEBCO e extrair os ficheiros.

Caso a grelha batimétrica ndo esteja, ainda, disponivel para download continar com o
exercicio mantendo a pagina de internet aberta e volte a esta pagina mais tarde.

8. Adicionar as estruturas submarinas representadas por pontos (“features-
-point.shp”) e linhas (“features-linestring.shp”).

8.1 O que significa a caixa de alerta de sistema de coordenadas que sur-
ge?

8.2 Necessita de definir uma transformacgao nova? Porqué?

C. SELECIONAR/FILTRAR DADOS POR ATRIBUTOS - “QUERY
BUILDER”

Neste ponto devera selecionar os pontos que representam apenas localizagcbes associa-
das a montes submarinos, para tal devera filtrar a informag¢ao com base nas caracteristi-
cas descritas na respetiva tabela de atributos.

9. Criar uma nova shapefile de pontos que contenha apenas os pontos rela-
cionados com montes submarinos. Explorar a tabela de atributos da cama-

da features-point.

9.1 Qual(quais) o(s) atributo(s) que permite(m) distinguir os montes sub-
marinos?

9.2 Fazer uma selec¢ao por forma a individualizar apenas os pontos do
tipo: Seamout, Bank, Ridge ou Terrace. Utilizar a opgao Definition
Query, disponibilizada na caixa de propriedades da camada de dados
(Figura 2, esquerda).

2 Para conseguir descarregar dados de batimetria do sitio GEBCO devera fazer um registo no sitio de internet.
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9.3 Carregar em Query Builder e construir a condicao que permite sele-
cionar apenas os pontos pretendidos (Figura 2, direita). Apos selecionar
o atributo base para a seleg¢ao carregar em Get Unique Values para ver
todas as opcdes de valores descritos nesse campo. Quando terminar a
condigédo, utilizar a opgao Verify para ver se a expressao nao apresenta
erros, antes de fazer OK.

General | Source | Selection | Display | Symbolegy | Fields | Defintion Guery | Labels | Joins & Relates | Time | HTML Fopup “FID"

Nk
Definition Query: "name"
“type”
"meeting”
"proposer” ¥

<> Like
> = | And

< == Qr

%) | () | | Net

Query Builder...
13 Get Unigue Values | Go To:

SELECT * FROM features-point WHERE:

Clear Verify Help Load. Save

Ccer| | Aplear Cancel

Figura 2 - Caixa de selegdo de dados — Query (esquerda) e caixa de constricdo de condigdes de selecdo
(direita).

9.4 Criar uma nova shapefile apenas com os dados que respeitam a con-
dicao definida, através de Data» Export Data (disponivel carregando com
BLDR sobre a camada de dados). Gravar a nova shapefile com o0 nome
“Gebco_seamounts.shp”.

Enquanto a expressao de condicao se encontrar em Definition Query, a camada de

dados comporta-se como se tivesse apenas esses dados. Para voltar a apresentar a
totalidade dos dados desta camada devera apagar a expresséao efetuada.

D. SELECIONAR/FILTRAR DADOS ESPACIALMENTE - CLIP

Pretende-se individualizar/extrair os pontos de montes submarinos e as estruturas linea-
res que estejam geograficamente nas aguas marinhas portuguesas.
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10. Aplicar a ferramenta Clip (Analysis tools - Extract) as camadas de dados

com os montes submarinos (SEEF e GEBCO) e a camada de dados com as
estruturas geolégicas (camada features-linestring).

10.1 Fazer Clip as diferentes camadas de dados utilizando a camada de

aguas marinhas Portuguesas como estrutura de “corte” (Figura 3).

10.2 Gravar cada uma das shapefiles de output com “ PT” no final do

nome.

ArcToolbox

ArcToolbox % Input Features

INPUT

B3 3D Analyst Tools I
= @ Analysis Tools

% Clip Features
= % Extract

o

< ER !
K\% Select # Output Feature Class
#, Split
x& Table Select XY Tolerance (optional)
& Overlay
& Proximity
&y Statistics
B3 Cartography Tools
& Conversion Tools
&) Data Interoperability Tools
&) Data Management Tools
£ Editing Tools
B Geocading Tools
B Geostatistical Analyst Toals
& Linear Referencing Tools
@ Multidimension Tools
B3 Network Analyst Tools
@ Parcel Fabric Tools
a Schematics Tools
@ Server Tools Environments...
@ Spatial Analyst Tools

Figura 3 - Ferramenta Clip.

10.3 Remover as camadas de dados auxiliares, deixando apenas as que

\ o

Decmal degrees +

CLIP FEATURE

>

<< Hide Help Tool Help

estdo incluidas nas zonas marinhas portuguesas.

Os passos efetuados de seleg¢ao por atribu-

tos (“Query”) e de selegao espacial (“Clip”)

poderao ser realizados de diversas formas,

nomeadamente através do menu Selection,

onde podera escrever as condi¢ées que per-
e mitem filtrar os dados pretendidos:

Esta opcao, no entanto, apenas seleciona os
dados e se pretender gerar uma nova shape-
file com essa informacao devera fazer Export
Data e escolher opgao de exportar apenas os

dados selecionados.

Selection | Geoprocessing Custornize

% Select By Attributes...
%| Select By Location...

Interactive Selection Method
Selection Options...

3
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11. Explorar espacialmente os dados disponiveis. Para facilitar a visualiza-
¢ao, podera colocar alguma transparéncia na camada de dados das aguas
marinhas portuguesas (no separador Display da caixa de propriedades da
camada) (Figura 4).

11.1 Quais os montes submarinos que se encontram na Area Marinha
Protegida — GreatMeteor? Qual a camada de dados Seamounts mais
completa (no que respeita GreatMeteor)?

11.2 Que estruturas cruzam a AMP Madeira Tore? Esta area marinha dis-
tribui-se em que tipologia de aguas marinhas?

As questbes deste ponto podem ser rapidamente verificadas com a ajuda da fungéo
Select by Location no separador Select. Aqui podera definir uma condigao e aplica-la a
multiplas camadas de dados (e.g. registos das camadas de pontos e linhas que cruzem
uma camada de AMP). Explore as diferentes tabelas de atributos com a op¢ao “Show

selected records”
o x
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
Oe2ds B x| 9 & - ([0 Q=S el :
QEMQ L e [ TN @ B M S TR | Georeferencing v  E—
fiooz B Editor~ -
Table Of Contents 3 x ~ &
Ees8Q g
2 = Layers =
= [ Seef_seamounts_PT
° &
E .ﬁﬁbm)eamuunls}T = %
5 B Gebeo EstGeo PT ™ a
— =]
b
gr o{® A g
@ o E
oY g2 ¥ - 1) E{
1 by et H
3 - o E
= AEa /ﬁ— 7
- - A 5
'kn' L
=}
v
Bl &
Drawing~ K O-A 0) Adal “10 vB 1 UlA-H.2

-3515985.289 5546791595 Meters

Figura 4 - Cruzamento de informagao espacial proveniente de varias fontes de dados.

E. ADICIONAR DADOS DE BATIMETRIA DE FUNDO | MODELO DE
DADOS MATRICIAL

12. Adicionar a malha batimétrica dos fundos submarinos descarregada do
sitio da GEBCO.
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12.1 Fazer Add data e adicionar o raster descarregado (ou arrastar o
ficheiro ascii através do ArcCatalog). Aceitar a geracéo de piramides que
facilitam a visualizagao espacial da malha de dados especialmente duran-
te a ampliacdo do mapa.

12.2 O que representa o aviso acerca do sistema de coordenadas que
surge?

12.3 Ap06s fazer OK, verificar se a matriz de dados esta corretamente loca-
lizada (georreferenciada)?

12.4 Qual o sistema de coordenadas do raster?

12.5 Utilizar a ferramenta Define Projection para atribuir a informacao
acerca do sistema de coordenadas da malha batimétrica. Definir em Coor-
dinate System o sistema de coordenadas em que se encontram os dados
(Figura 5).

ArcToolbox o x

= & Data Management Tools " . .
&y Archiving % Input Dataset or Feature Class Define PijECtIOl‘I
% Attachments
& Data Comparison This tool overwrites the

% Coordinate System . . .
& Distributed Geodatabase coordinate system information

& Domains (map projection and datum)
&y Feature Class stored with a dataset. The only
& Features use for this tool is for datsets
& Fields that have an unknown or

& File Geodatabase incorrect coordinate system
defined.

& General

& Generalization

&) Geodatabase Administration

& Geometric Network

All geographic datasets have a
coordinate system that is used

throughout ArcGIS to display,

& Graph measure, and transform

& Indexes geographic data. If the

& Joins coordinate system for a dataset
& LAS Dataset is unknown or incorrect, you
&y Layers and Table Views can use this tool to specify the
& Package correct coordinate system. You
& Photos must know the correct

= & Projections and Transformat coordinate system of the

& Raster dataset before using this tool.

[ Batch Project
’(\ Convert Coordinate Nota

"\ Create Custom Geograph >

“\ Create Spatial Reference

:} Define Projection v Cancel Environments. .. << Hide Help Tool Help
< >

Figura 5 - Ferramenta Define Projection, para atribuir um sistema de coordenadas a dados que ndo tenham
sistema de coordenadas ou estejam mal atribuidos.

12.6 Qual a profundidade maxima observada?

13. Editar a simbologia da batimetria com uma gradagao de cores a sua
escolha.
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F. PERFIL TOPOGRAFICO | BARRA DE FERRAMENTAS 3D

ANALYST

3D Analyst - |[@ GEBCO2014_-420280 7. 7] B & o L[E|8 - @1 @

A Barra de ferramentas 3D Analyst permite realizar uma série de tarefas de analise
espacial raster de forma rapida e local, sem ter de aplicar as ferramentas de processa-
mento a todo o raster. Uma das tarefas mais usuais € a realizagao de perfis topograficos
(batimétricos ou de outra natureza) pela interpolagao dos valores da malha ao longo de

uma linha (carregando em 2/, desenhando a linha para a qual se quer fazer a interpola-

cao e de seguida em k=-).

14. Fazer um perfil batimétrico, orientado NE-SW, sobre o banco Goringe
com as ferramentas disponibilizadas na barra de ferramentas 3D Analyst

(Figura 6).

15. Repetir o ponto anterior para a orientagao perpendicular.

15.1 Qual a cota maxima atingida em Goringe?

15.2 Qual a altura aproximada do banco Goringe relativamente aos fundos

adjacentes?

File Edit View Bookmarks Insert Selectior

ing Customize Windows Help

Daﬂ% %@%x ool b- m.-n@mm&» &I - | KT HIS % ©EY

£ [ Seef_seamounts PT

o
& [ Gebeo_EstGeo_PT

- 1 m 6724755
1016724756 - 2440130411
12440139412 - 427024397
[14.270243971 - 6.507038431
[16.507038432 - 9150522793
[19.150522704 - 12.20069706
[ 12.20068707 - 1586080617
[ 15.86090618 - 2135121985
-21 35121986 - 51.85296249
Value
W High: 3896

Low : -6406

3
3 y:
3D Analyst~ | [ GEBCO2014_-42.028.07.v] /B s

[woaosay @] [sineen B [seineasamaro B [ueieas & |Goreeo ]|

O IR T a— TP SR

-1040879.300 4206057.953 Meters

Figura 6 - Perfil batimétrico por interpolagédo dos valores da malha ao longo de uma linha.
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G. MAPA DE DECLIVES - (OPCIONAL)

16. Transformar a informacao batimétrica em informacao acerca dos decli-

ves submarinos.

16.1 Fazer um mapa de declives (em graus) a partir da malha batimétri-
ca utilizando a ferramenta Slope (3D Analyst tools » Raster surface ou
Spatial Analyst tools ™ Surface) (Figura 7).

16.2 Verificar os resultados e apontar uma explicagao para os valores

calculados.

16.3 Repetir o ponto 16.1, alterando o sistema de coordenadas de saida
para PTRAO8 LAEA_ Europe nos Environment Settings da ferramenta

Slope:

16.3.1 Carregar em Environments » Output Coordinates e em
Output Coordinate System escolha As Specified Below e definir o
sistema/projecéo pedido.

16.4 Explicar porque os resultados sao diferentes do calculo de declives

anteriormente realizado.

16.5 Qual o flanco mais inclinado do banco de Goringe?

ArcToolbox

[ ArcToolbox A
= Q 3D Analyst Tools
& 3D Features
& CityEngine
& Conversion
& Data Management
& Functional Surface
& Raster Interpolation
& Raster Math
& Raster Reclass
= & Raster Surface
g\ Aspect
g\ Contour
g\ Contour List
g\ Contour with Barriers

K\ Curvature
#, CutFill
#, Hillshade
sicr-
& Triangulated Surface
& Visibility
B3 Analysis Tools

Figura 7 - Ferramenta Slope (do grupo 3D Analyst tools) para calculo de declives.

% Input raster

% Output raster

Qutput measurement (optional)
DEGREE

2 factor (optional)

OK Cancel

Environments. ..

>

<< Hide Help

Slope

Identifies the slope (gradient, or
rate of maximum change in z-
value) from each cell of a raster
surface.

Tool Help
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H. CALCULO DE VOLUMES (OPCIONAL)

Neste ponto pretendemos calcular o volume de rocha que constitui o banco Goringe,
para isso devera ser criada uma shapefile do tipo poligono que envolva toda a area do
banco e que servira como mascara para o calculo do volume.

Esse poligono foi previamente criado (tendo por base os limites definidos na Resolugao
de Conselho de Ministros n.° 59/2015) e podera ser adicionado ao seu projeto.

17. Adicionar o poligono que limita a area do banco Goringe que se encon-
tra na pasta do exercicio.

18. Cortar o raster que representa a batimetria pelos limites do banco Go-
ringe:

18.1 Utilizar a ferramenta Extract by Mask (Spatial Analyst Tools » Ex-
traction). Definir o sistema de coordenadas de saida para PTRAO8
LAEA_Europe nos Environment Settings da ferramenta (Figura 8).

Este procedimento ird gerar um novo raster batimétrico limitado pelo poligono
que foi utilizado como mascara, a definicdo do sistema de coordenadas de saida
fara com que o raster gerado seja definido no sistema de coordenadas PTRAQ8
LAEA Europe, sendo o mais apropriado para efetuar os calculos subsequentes.

ArcToolbox ox

& Geocoding Tools ~

B Geostatistical Analyst Tools % Inputraster Extract by Mask

e Linear Referencing Tools I

B Multidimension Tools ., Extracts the cells of a raster
B Network Analyst Tools I that correspond to the areas

defined by a mask.

& Parcel Fabric Tools
@ Schematics Tools
& Server Tools
= B Spatial Analyst Tools
& Conditional
& Density
&y Distance
= & Extraction
#, Extract by Attributes
J\% Extract by Circle
’r\% Extract by Mask
"\% Extract by Points
ar‘ Extract by Polygon
“% Extract by Rectangle
#, Extract Multi Values to Pc
#, Extract Values to Points
J\% Sample
& Generalization
& Groundwater

§ Hydrolagy v Cancel Environments... << Hide Help Tool Help

% Output raster

>

Figura 8 - Ferramenta Extract by Mask para cortar dados matriciais utilizando uma mascara.
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19. Calcular o volume de rocha que se encontra acima das profundidades
dos 4000m, 3000m, 2000m e 1000m.

19.1 Utilizar a ferramenta Surface Volume aplicada ao raster de Gorin-
ge. Definir um nome para o ficheiro de gravagéo dos resultados (Figura
9). Repetir o procedimento para as diferentes profundidades, utilizando o
mesmo ficheiro para a gravacao dos resultados.

ArcToolbox Oox

[ ArcToolbox A

) B9 30 Analyst Tools ® Input Surface Surface Volume
& 30 Features

& CityEngine Output Text Fle (optional) Cfalculates th_e areia ar:jd_volunre
& Conversion | of a raster, triangulated iregular

& Data Management network (TIN), or terrain dataset

=) & Functional Surface "M@Pﬁﬂﬂ surface above or below a given
#, Add Surface Information ABOVE reference plane.
4, Interpolate Shape ’I?Mgh_t(mr}
#, Intersect 30 Line With Su
#, Stack Profile 2 Factor {optional)
"\ Surface Volume

& Raster Interpolation Pyramid Level Resolution (optional)
% Raster Math 0
& Raster Reclass
% Raster Surface
& Triangulated Surface
& Visibility
@ Analysis Tools
e Cartography Tools
° Conversion Tools
° Data Interoperability Tools
° Data Management Tools

&) Editing Tools =
9 Geocoding Tools ] Cancel | |Environmems... | | << Hide Help | | Tool Help
< >

Figura 9 - Ferramenta Surface Volume para o célculo de volumes.
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Exercicio 4
ANALISE ESPACIAL

Objetivos
Este exercicio tem por objetivo a implementacdo de um sistema de carateri-

zacdo e classificagdo de materiais dragados através de um estudo de caso -

Porto de Vila do Conde, exemplificando as diversas fases de um projeto SIG.

0O sistema desenvolvido tem como base a legislacdo em vigor para a pro-
tecdo do meio marinho e a regulamentacao das operacdes de dragagem. O
resultado final permitira a avaliacdo da qualidade ambiental dos materiais
dragados para efeitos de imersao no mar.

Serdo aplicados métodos de interpolacao e classificacdo, desenvolvendo
competéncias de analise quantitativa dos fendmenos espaciais.

A.ESTUDO DE CASO

Pretende-se avaliar a qualidade ambiental dos materiais dragados no Porto de Vila do
Conde (Figura 1) para efeitos de imersdo no mar.

Figura 1 - Localizagéo da area de estudo — Vila do Conde.
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A caraterizacao dos dragados sera efetuada segundo a Portaria n.° 1450/2007, de 12 de
Novembro, que classifica o material dragado de acordo com o grau de contaminacao de
alguns elementos metais e compostos orgéanicos (Tabela 2) e os niveis de agéo estabe-

lecidos para cada classe (Tabela 3), ambos em Anexos.

1. Integragao, conversao e geoprocessamento da informagao geografica em SIG

Os dados de base deste exercicio, cuja descricdo se encontra em anexo, sao:
a. Levantamento topo-hidrografico do Porto de Vila do Conde;

b. Coordenadas das estagcdes de amostragem nos sedimentos dragados;

c. Analises quimicas aos sedimentos dragados de superficie;

d. Area de dragagem do Porto de Vila do Conde - Cais das Lavandeiras.

Neste exercicio faz-se uso de diferentes tipos de dados, de forma a integrar a informa-
¢ao geoespacial no projeto SIG.

1.1 Preparacgao do projeto SIG

1. Iniciar o ArcMap.

2. Alterar o nome do georreferencial pré-definido para Drag_Vconde: clicar com
o BLDR no nome do georreferencial » Properties ™ General ™ Name.

3. Gravar o projeto SIG na diretoria ...\ PROJECTO_AE, atribuir o nome, por
exemplo, Drag_Vconde.mxd.

1.1.1 Exploracéo dos dados - Catalog

1. Aceder ao Catalog.

2. Explorar os ficheiros fornecidos na pasta Ex4 verificando os formatos de
dados e eventuais necessidades de conversao de informacao.

3. Clicar sobre a pasta que contém o ficheiro CAD e abrir o desenho (*.dwg)
relativo ao levantamento topo-hidrografico do Porto de Vila do Conde.

4. Visualizar as 5 classes contidas no desenho (*.dwg), clicando com o BLDR
sobre o ficheiro » Item Description.

5. Observar os dados de cada uma das classes para em seguida selecionar
que dados pretender converter de CAD para shapefile.

6. Verificar se os dados tém sistema de coordenadas definido e a informagao
contida nos metadados’.

" Apesar de ndo constar nos metadados dos ficheiros CAD os seus elementos apresentam-se georreferenciados ao Siste-
ma Hayford-Gauss, Datum Lisboa (em ArcMap este sistema designa-se por Lisboa Hayford Gauss IPCC) e cotas altimétri-
cas referidas ao Z.H. (-2,0 m NMM), Datum altimétrico Marégrafo de Cascais.
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A partir da versao 10 do ArcMap o Catalog (uma aplicacao simplifica-
da do ArcCatalog) pode ser executado dentro da aplicagcao ArcMap

10 através quer da barra que lhe aparece no lado direito da janelam ,
quer através do botdo de acesso na barra de menu [i.

BoeE s

Cada ficheiro CAD (*.dwg) é constituido por 5 classes de entidades
diferentes: rontents

Preview | Description

Mame Type
IEF'.nnu:utatinn CAD Annotation Feature Class
[E] MultiPatch CAD MultiPatch Feature Class
[~ ]Paint CAD Point Feature Class
[EPalygan CAD Polygon Feature Class
|E|Pnlyline CAD Polyline Feature Class

A informacao encontra-se em diferentes formatos pelo que teremos de proceder a sua
integracdo em duas fases. Para a correta integracao da informacgao geografica num
projeto SIG a definigao do sistema de coordenadas de todos os elementos do mapa
€ essencial. Nos formatos que n&o sdo nativos do ArcGIS (e.g. ficheiros CAD) este
procedimento deve ser efetuado durante a sua importacédo e tendo em consideragao os
elementos que deverao constar nos metadados.

1.1.2 Integragéo e geoprocessamento da informagcédo CAD

1. Com o BLDR no ficheiro LevTopoHidro.dwg selecionar Properties. Na
caixa de didlogo CAD Feature Dataset Properties, separador General, se-
lecionar o botao Edit e selecionar o sistema de coordenadas adequado.

2. Exportar os temas CAD do tipo ponto e linha, contidos no ficheiro CAD
(*.dwg), para o formato shapefile, que é um dos formatos de dados vetorial
utilizado pelo ArcGIS.

A informagao CAD pode ser visualizada diretamente no ArcMap, sem
necessidade de importagao, no entanto as capacidades de analise e
edigcao ficam muito limitadas.

3 ArcCatalog - Arclnfo - E:\SIG_formaca \SIGAIA_201012_AE\DATAexe1_AnaliseEspacial\levTopoHidro. dwg\Point

Fle Edt Vew Go Tooks Window Help

a. Com o BLDR sobre o tema Point» .- = eaennw|aanecs o
Location:  [E-\SIG_formacao\SIGAIA_2010\2_AE\DATAexeT_AnaliseE spacialLevT opoblicio.dn v
Export » To Shapefile (single). e | R
= -
b. Na janela selecionar como localiza- S

sz

¢ao do ficheiro (Output Location)
a pasta onde pretender guardar os
resultados e como nome do ficheiro

* 1 DATAere:
D oA gt ropers...
(3 wisiG_2007

(Output Feature Class) o nome &) S

(22 System volume Information
% (0 UscP_bbl

PTcotas. ai

51260,
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c. Com o BLDR sobre o tema Polyline » Export »To Shapefile (single).

d. Na janela selecionar como localizagéo do ficheiro (Output Location) a
pasta onde pretender guardar os resultados e como nome do ficheiro
(Output Feature Class) o nome LIMterra.

e. Verificar as duas camadas vetoriais criadas.

w

. Adicionar a informacao ao georreferencial:

a. Adicionar o tema com a definicdo da area a dragar (areaDrag.shp).

b. Adicionar, caso ndo tenham sido adicionados automaticamente, os temas
LIMTerra.shp e PTcotas.shp. Observar que as camadas adicionadas
apresentam informagéo desnecessaria, necessitando de alguns procedi-
mentos de edigao.

N

. Editar a informacéao desnecessaria:

o

Apagar as linhas e pontos que achar desnecessarias em ambas as cama-
das de dados. (Ativar o modo de edigdo de camadas em Editor > Start
Editing para poder apagar elementos)

5. Adicionar uma imagem aérea com o servigo de basemaps do ArcGIS: Add
Basemap » Imagery; ou um orto com o servigo WSM do IGEO.

6. Se observar um desfasamento entre a fotografia e os dados vetoriais corri-
ja-o. Qual a explicagao para este desfasamento?

1.1.3 Integracao de informagao em formato alfanumérico
Aincorporacao de dados alfanuméricos (e.g. tabelas Excel, bases de dados
nao geograficas, ficheiros .txt) é realizada diretamente no ArcMap.

1. Adicionar as tabelas Coord_EstAm.dbf e EstAm10s.dbf ao georreferen-

cial e observar a informagao nelas contida.

2. Representar a localizacdo das amostras:

a. Sobre a tabela Coord_EstAm.dbf e com o BLDR W Display XY Data.

b. Na janela escolher os campos correspondentes a informagdo X e Y e
selecionar o correto sistema de coordenadas, se necessario (ver Tabela 1
em anexo).

c. O tema criado corresponde a uma Event Layer que nao esta gravada no
disco, sendo necessario torna-lo permanente exportando-o: BLDR W Data
» Export Data gravando com o nome Pt_Estam.

d. Adicionar o novo tema e apagar a tabela e a Event Layer criada.
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3. Relacionar as duas tabelas a partir de um campo em comum:

a.

Analisar ambas as tabelas e encontrar

um campo comum (DESIG_ESTA* - Join Data

Join lets you append additional data to this layer's attribute table so you can,

Des | g n agéo da esta Qéo ) ) for example, symbolize the layer's features using this data.
What do you want to join to this layer?
Com (0] BLDR SObre a Pt_EStam.Shp Join attributes from a table w
Se I eCiona r Joins and Relates > Join . 1. Choose the field in this layer that the join will be based on:
DESIG_ESTA w

Na janela selecionar a opgéo Join

2. Choose the table to join to this layer, or load the table from disk:

attributes from a table, em 1. sele- ' R |
Clonar O Campo Comum da tabela que [+] show the attribute tables of layers in this list

3. Choose the field in the table to base the join on:

a vai fazer a ligacao, em 2. selecionar

DESIG_ESTA w
a tabela a que se ira juntar e, em 3. nopiens

®) Keep all records
0 campo comum da tabela que se ira et ol ot o ol ek e

appended into the target table from the join table.

juntar. Fazer OK. .

1 (_) Keep only matching records
Abrir a tabela de atributos do tema ! e e ot o o
Pt_Estam.shp. Verificar que os con-
teudos da tabela EstAm10s.dbf estao

ligados a tabela de atributos de Pt_Es- &=~ ores

Validate Join

tam.shp. Fechar Tabela de atributos.

1.1.4 Conversao de formatos de dados (vetorial/matricial) — definicdo de
mascaras

O préximo passo € a delimitagcao da area de estudo para a caracterizacao
dos materiais dragados (area de dragagem), de forma a definir a area de
analise espacial. Neste caso, pretende-se que a mascara também se encon-
tre definida em modelo matricial.

1. Converter o tema areaDrag.shp (em formato vetorial) para o formato ma-

tricial.

Utilizar a ferramenta de conversao Polygon to Raster definindo os parame-
tros abaixo especificados. Gravar o ficheiro com o nome areaDrag.

. Polygon to Raster

Input Feaktures
IareaDrag LI ﬂ
Walue field

GRIDCODE v
Qutp\.ll: Raster Dataset

C:\Documents and SettingsiElisabetel Ambiente de trabalholAE\DATAexel _AnaliseEspacialiResultados | B-I
Cell assignment type {optional)

MAXIMUM_AREA v|
Priority field {optional)

GRIDCODE v/
Cellsize (optional)

£ | &)
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2. Interpolagao de dados pontuais

Os métodos de interpolacao sédo usados para estimar valores desconhecidos ao longo
do espaco, a partir dos valores de amostras pontuais. Existem numerosos métodos de
interpolagao espacial que permitem atingir este objetivo, sendo neste exercicio abordada
a triangulagdo e o inverso da distancia.

2.1 Triangulagao

Para proceder a interpolacédo de dados altimétricos ou batimétricos utiliza-se,
usualmente, um método baseado na triangulagdo dos pontos de observacao, em
que a superficie interpolada € composta por um conjunto de faces triangulares
planas (malha irregular triangulada - TIN). A caracteriza¢ao batimétrica da area
de dragagem ira basear-se neste método.

2.1.1 Construgao da malha triangulada — TIN
a. Pesquisar a ferramenta Create TIN e construir malha triangulada usan-
do os parametros abaixo especificados (gravar o resultado com o nome

“ Create TIN - b
Qutput TIN
1:\SOPHIA_CRIS\SIG_AE\STAGALA_2012\AE_2012\Meus Resultados_ExAE{Tin1 ]
Coordinate System (optional)
Lisboa_Hayford_Gauss_IPCC [:f
Input Feature Class (optional)
| =l e
Input Features Height Field SF Type Tag Field +
<PTeotes COTA Mass_Paints <MNone: =
< >
[] Constrained Delaunay (optional)

b. Como queremos que a andlise espacial corresponda apenas a area de
dragagem temos que limitar a superficie criada:

Com a ferramenta Edit TIN, defininir os par@metros abaixo indicados para
editar/restringir a TIN criada no ponto anterior, a area de dragagem (Figura 2).

N Edit TIN - =

Input TIN
|T|n1 ﬂ B
Input Feature Class
| = e

Input Features Height Field Tag Field SF Type Use Z +

< _ »areaDrag <None> <Mone > Soft_Clip false x

< >

[[] Constrained Delaunay {optional)
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Figura 2 - a) Resultado Create TIN e b) resultado Edit TIN.

c. Alterar a simbologia do tema Tin1 para uma gradagao de cores que
considerar adequada e usar a classificacédo por intervalos definidos pelo
utilizador, com intervalo de 1 m.

2.1.2 Calcular o volume de sedimentos a dragar

1. Calcular o volume de sedimentos a dragar na area de dragagem do tema

Tin1:

a. Usar a ferramenta Surface Volume, disponivel em ArcToolbox» 3D
Analyst Tools » Functional Surface, com os parametros abaixo defini-

dos.

Desta forma estara a calcular o volume de sedimentos que existem acima
do plano definido pela profundidade -2 m.

Surface Volume = =

Input Surface

ITm] LI E-

Qutput Text File (optional)

Reference Plane (optional)
ABOVE
Flane Height (optional)

Z Factor {optional)

Pyramid Level Resolution {(optional)
a

b. Qual o volume de sedimento a dragar?
Aceder aos resultados da ferramenta anterior em Geoprocessing » Re-
sults» Surface Volume» Messages. Em alternativa podera gravar um
ficheiro .txt com esta informagéao, configurando o campo Output Text File
(optional) do menu da ferramenta.
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Results XL
= @ Current Session
= ﬁb Surface Veolume [223724_09042015]
[ Output Text File: <empty=
@ Inputs
Ef‘ Environments
= [I] Messages
@ Executing: SurfaceVolume Tin1 # ABOVE-210
[ Start Time: Fri Sep 04 22:37:24 2015 ik il
@ Completed Surface Yolume: 2D Area=11511.265914152 3D Area= 116?3 64314[)96 Volume=30338.022229445
@ Succeeded at Fri Sep 04 22:37:24 2015 (Elapsed Time: 0.00 seconds)| [

Ixoqmm_:uv a‘ Isunsaa @‘

2.1.3 Conversao da TIN para matricial

Em seguida vai se converter o tema da TIN1 para o formato matricial.

a. Com aferramenta TIN to Raster criar um raster com o nome Batimetria.
A dimensao da célula é de 1 e o raster criado devera ser do tipo Float
(permite casas decimais).

N TIN to Raster - O
Input TIN
ITm1 ;I B
Output Raster
1:\SOPHIA_CRIS\SIG_AE\SIAGAIA_2012\AE_2012'\Meus Resultados_ExAE\Batimetria B

Output Data Type (optional)
FLOAT

Method {optional)
LINEAR

Sampling Distance (optional)
CELLSIZE 1

Z Factor (optional)

b. Representar a nova superficie com uma gradagéo de cores que conside-
rar apropriada.

c. Calcular o volume de sedimentos a dragar na area de dragagem utilizan-
do o tema Batimetria e a ferramenta descrita anteriormente. Comparar
com o resultado anterior. Discutir a origem das diferencas.

2.2 Inverso das distancias

Para caracterizar os materiais dragados € necessario interpolar, para toda a area
de dragagem, os valores de concentragao das substancias quimicas analisadas
nas amostras de sedimentos (recolhidas em pontos de amostragem especificos
e em fungdo da cota de dragagem, da espessura da coluna de dragados, etc.).
Neste caso podem ser usados variados meétodos de interpolagéo, como métodos
deterministicos (e.g. IDW e Spline) e geoestatisticos (e.g. krigagem). Na resolu-

cao deste exercicio vamos usar o método de interpolagao Inverso da Distancia
Ponderada IDW~2.

2 IDW —inverso da distancia ponderada — a forma como este método funciona pode ser consultada em:
http://resources.arcgis.com/EN/HELP/MAIN/10.2/index.html#/How_IDW_works/009z00000075000000/
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Analisando os resultados das analises quimicas realizadas aos sedimentos de
Vila do Conde, e comparando-os com os niveis de agao da legislagdo em vi-

gor (Portaria n.° 1450/ 2007), observa-se que das varias substancias quimicas
analisadas, o Pb (Chumbo) e Cu (Cobre) sdo as que apresentam um maior grau
de contaminacgao, pelo que ndo apresentam aptidao ambiental para a imersao no
mar (Tabela 2 e Tabela 3).

Neste sentido, e para simplificar a execugéo deste exercicio, vamos considerar
apenas, para efeitos de analise espacial, estas duas substancias quimicas e
sobre elas realizar as operagdes de interpolacao.

2.2.1 Interpolagao do elemento Chumbo
1. Usando a ferramenta IDW, disponivel em ArcToolBox W Spatial Analyst

Tools W Interpolation.
a. Preencher os elementos da janela com os parametros abaixo representa-
dos:
- IDW -

Input point features
| Pt_Estam ﬂ 3]
Z value field

ESTAM10s.PB W
Qutput raster

1:\SOPHIA_CRIS\SIG_AE\SIAGAIA_2012\AE_2012\Meus Resultados_ExAE\idw_Pb E}‘
Output cell size (optional)

t =]
Power {optional)

2

Search radius {optional)

Variable ™

Search Radius Settings

Mumber of points: 12

Maxdmum distance:
Input barrier polyline features {optional)
| K=

Cancel Environments. .. Show Help ==

b. Abrir o separador Environments para definir a area de andlise:
i. Processing Extent » Extent: same as layer Batimetria.

% Processing Extent
Extent

Same as layer Batimetria w

s

ii. Raster analysis W Cell size: As specified below» 1; Mask:
Batimetria
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# Raster Analysis
Cel Size

As Spedcified Below =

Mask

Batirmetria LI E-

iii. Ok.
c. Ok

2.2.2 Interpolagao do elemento Cobre
1. Repetir o procedimento agora para o cobre (sugestao: utilizar a janela Re-

sults para visualizar o procedimento utilizado no chumbo e alterar a variavel
utilizada na interpolacéo).

2. Modificar a simbologia de forma a representar em vermelho os valores de
concentracado de contaminagdo mais elevados, e tons de azuis nos valores
de concentragdo mais baixos. Repetir para o Pb (Figura 3).

a) b)
Figura 3 — a) Superficie de interpolacdo do Pb e b) Superficie de interpolagao do Cu.

2.3 Classificagao das superficies interpoladas

Tendo por base a legislagéo legal em vigor para a protecdo do meio marinho,
que se traduz nas tabelas anteriormente apresentadas, é possivel classificar os
sedimentos dragados relativamente a sua qualidade ambiental para a imersao no
mar (Tabela 2 e Tabela 3).

1. Classificar as superficies de interpolacédo das substancias Pb e Cu de acordo
com a Tabela 2, usando a operacao de reclassificacao — Reclassify:
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a. ArcTooolbox W Spatial Analyst Tools » Reclass W Reclassify usando as
seguintes configuracoes:
Input raster: idw_pb;
Reclass field: value;
Reclassification:
» Classify » Classification » Classes: 4 » Method: Manual » Break
Values» 50, 150, 500, 1000 p> OK.
Output raster: cls_idw_pbp OK.

= e
%, Darlacrif

- o 15 e
Classification
Lplizeicy Classification Classification Statistics
idw_Pb Method:  Manual v Counts o2z
Reclass field Classes: | 4 Mirimum: 41.241653
Value . Maximum: 521.998108
Redassification oz &z Sum: 1747086.66272
Mean: 136.246328
Ol valics Hew vahics: @ 3 Exchen Sekrg - Standard Deviation: 95.248428
41241653 - 80 111015 1 Classify...
80 111015 - 108.984779 z rique Columns: | 100 |5 ["Ishow Std. Dev. [[Ishow Mean
¥ Unique
i BreakValues | %
= 1500
5 Add Entry 2 2 50
& 150
7 Delete Entries 500
337.805039 - 419 541962 8 v
Load... | Save.. Reverse New Valuss | | Precision... 1000
Output raster
C:\Users\Utilizador\Documents\ArcGIS\Default1. gdb\Redass _idw_1
500+
[] Change missing values to MNoData (optional)
< >
41241653 161430767 281619881 401808994 521998108
[[]snap breaks to data values 46 Elements in Class Cancel

2. Repetir para o cobre (ter em atencao que as classes deverao apresentar limi-
tes distintos em fung&o do descrito na Tabela 2).

3. Representar os temas com uma gradacéo de cores que considerar adequada.

Opcionalmente a reclassificagao das superficies poderia ser con-

cretizada utilizando a fung¢ao condicional (con). Neste caso, em

ArcTooolbox W Spatial Analyst Tools» Map Algebra® podera con-
0 struir a seguinte expressao:

CON(“idw_pb” >=1000, 5, CON((“idw_pb” < 1000) & (“idw_pb” >=
500) , 4, CON ((“idw_pb” < 500) & (“idw_pb” >=150) , 3, CON((“idw_
pb” < 150) & (“idw_pb” >=50) , 2, 1))))”

2.4 Classificagado dos sedimentos (algebra de mapas)

A classificacdo dos sedimentos em determinada posi¢cao depende da classifica-
¢ao atribuida ao elemento que apresente a maior classe de contaminacéo nesse
local. Nesse sentido, é necessario fundir as superficies geradas anteriormente,
usando a fungao estatistica MAXIMUM.
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A classificacao final de uma amostra de sedimentos resulta da conjugacéao da
classificacdo das 11 substancias quimicas analisadas, i.e., 0 maximo em todas
as substancias. No caso deste exercicio, como usamos apenas 2 elementos,
faremos este calculo apenas nestes dois elementos.

1. Usar a ferramenta Cell Statistics com os parametros abaixo indicados:

- Cell Statistics = B
Input rasters or constant values
| =]
<ds_idw_Cu +
<> dls_jdw_Pb
x
1
Qutput raster
J:\SOPHIA_CRIS\SIG_AE\SIAGAIA_2012\AE_2012\Meus Resultados_ExAE\max_amostra
QOverlay statistic (optional)
MAXIMUM W
lgnore NoData in caleulations (optional)

2. Verificar qual o elemento que mais condiciona a qualidade dos sedimentos a
dragar.

2.5 Caraterizacao da aptidao ambiental dos sedimentos

Pretende-se, em seguida, determinar as areas com aptidao ambiental dos mate-
riais dragados para a imersao no mar. Assim vamos reclassificar a superficie com
0s maximos gerada no ponto anterior.

1. Com a ferramenta Reclassify, reclassificar os valores em 0 e 1 em fung¢ao da
informacao da Tabela 4 (0 — Proibida a imersao no mar; 1 — autorizada a imersao
no mar).

a. Usar os parametros abaixo definidos:

N Reclassify = E
Input raster
max_amostra | |
Redass field
VALUE w
Redassification
0ld values New values ~
1 1 Classify. ..
2z 1 U
5 i nique
4 0
MoData MoData Add Entry
Delete Entries
Load... Save... Reverse New Values Predision...
Output raster
1:\SOPHIA_CRIS\SIG_AE\SIAGAIA_2012\AE_2012\Meus Resultados_ExAE'ApAmb
[]Change missing values to NoData (optional)

2. Representar o tema gerado com uma gradagao de cores que considerar adequa-
da.
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2.5.1 Calculo do volume sedimentar adequado para imersao

Uma vez classificadas as areas de dragagem (quanto ao grau de contamina-
¢ao dos sedimentos a dragar/ nivel de agao), foi possivel delimitar zonas de
sedimentos a dragar com diferentes classes de contaminagéo e que exigem,
por isso, diferentes procedimentos ambientais, quanto a deposi¢cao desses
sedimentos.

Para calcular o volume de sedimento passivel de ser imerso no mar € neces-
sario isolar a mancha sedimentar respetiva e, em seguida, calcular o volume.
Neste processo pressupde-se que o sedimento é verticalmente uniforme.

1. Isolar a mancha de sedimento com aptidao para imersao no mar utilizando a
funcao Extract by Attributes (indicar um procedimento alternativo).

2. Isolar a batimetria associada a esta mancha de sedimentos utilizando algebra
de mapas ou a funcao Extract by mask. Pretende-se que deste ponto resulte a
informacao batimétrica apenas da area com sedimento apto a ser imerso no mar
(extrair da batimetria a area encontrada em 1)

3. Calcular o volume de sedimentos correspondente ao sedimento apto para
imersao considerando a superficie de base a cota de -2 m (o resultado devera
ser proximo de 28 000 m3).

4. Para calcular o volume de sedimentos com proibi¢do de imersao repetir os
passos 1 a 3, utilizando o Extract by Attributes com o atributo {Value = 0}. Em
alternativa podera fazer a diferenga aritmética entre o volume total (encontrado
em 2.1.3.c) e o volume estimado no ponto anterior.

B. ANEXOS

NOME DESCRICAQ TIPO FONTE SIST. COORD.

Levantamento topo-hidrografico do Rio *.dwg Hayford-Gauss;
IPTM,
(N2VANCIZ0EII/OM Ave numa area do Porto de Vila do (formato CAD) Dt Lisboa; Origem: PC;
I.P3.
Conde. cota ao Z.H.
Ficheiro com as coordenadas das es- *.dbf Sistema de Coordenadas
(@O[0[;N=SYVA\V/N tacOes de amostragem aos sedimentos (formato IPTMI.P. | Hayford-Gauss, Datum
dragados (tabela). dBaselV) Lisboa.
Ficheiro com aos resultados das analises *.dbf
IPTM,
ESTAMI0S quimicas aos sedimentos dragados de (formato -
I.P.
superficie (tabela). dBaselV)
) Hayford-Gauss;
Area de dragagem do Porto de Vila do *.shp IPTM,
AREADRAG Dt Lisboa; Origem: PC;
Conde, Cais das Lavandeiras. (shapefile) I.P.
cota ao Z.H.

Tabela 1 — Descrigéo dos ficheiros de base deste exercicio.

3 IPTM, I.P. — Instituto Portuario e dos Transportes Maritimos, I.P., atualmente Direcdo Geral dos Recursos Naturais,
Seguranga e Servigos Maritimos - DGRM (https://www.dgrm.mm.gov.pt)
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PARAMETRO | CLASSE1 CLASSE 2 CLASSE 3 CLASSE 4 CLASSES
METAIS (MG/KG)
Arsénio (As) | <20 [20-50[ [50-100] [100 — 500] > 500
Cadmio (Cd) | <1 [1-3[ [3 - 5[ [5-10] >10
Crémio (Cr) | <50 [50 — 100[ [100 — 400[ [400 - 1 000] > 1000
Cobre (Cu) | <35 [35 - 150] [150 — 300] [300 — 500] > 500
Mercurio (Hg) | <0,5 [0,5-1,5] [1,5-3,0[ [3,0 —10] >10
Chumbo (Pb) | <50 [50 — 150[ [150 — 500[ [500 - 1 000] > 1000
Niquel (Ni) | <30 [30 — 75 [75 — 125] [125 — 250] > 250
Zinco (Zn) | <100 [100 — 600] [600 - 1 500] [1 500 - 5 000] > 5000
COMPOSTOS ORGANICOS (G/KG)
PCB (soma) |<5 [5 - 25[ [25 - 100] [100 — 300] > 300
PAH (soma) | <300 [300 - 2 000] [2 000 - 6 000] [6 000 - 20 000] > 20 000
HCB <0,5 [0,5 - 2,5 [2,5-10[ [10 - 50] > 50

Tabela 2 -Classificagdo de materiais dragados de acordo com o grau de contaminagao, adaptado da Portaria n.°
1450/2007, de 12 de Novembro.

Material dragado limpo - pode ser depositado no meio aquatico ou reposto em locais sujeitos a erosdo

ou utilizado para alimentagéo de praias sem normas restritivas.

Material dragado com contaminacdo vestigidaria - pode ser imerso no meio aquatico tendo em

atengéo as caracteristicas do meio recetor e o uso legitimo do mesmo.

Material dragado ligeiramente contaminado - pode ser utilizado para terraplenos ou no caso de

imersao necessita de estudo aprofundado do local de deposigao e monitorizagao posterior do mesmo.

Material dragado contaminado - deposigéo em terra, em local impermeabilizado, com a recomendacgéo

de posterior cobertura de solos impermeaveis.

Material muito contaminado - idealmente no sera dragado; em caso imperativo, deverao os dragados

ser tratados como residuos industriais, sendo proibida a sua imersao e a sua deposicdo em terra.

Tabela 3 — Niveis de Agéo - Classes de qualidade dos sedimentos (material dragado), adaptado da Portaria n.°
1450/2007, de 12 de Novembro.

COM AUTORIZACAO 1
CcoM AUTORIZACAO 1
COM AUTORIZACAO 1
SEM PROIBICAO 0
SEM PROIBICAO 0

Tabela 4 — Classes de aptiddo ambiental.

Valor 1 — sedimentos dragados com aptiddo ambiental para a imersdo no mar;
Valor 0 - sedimentos dragados sem aptiddo ambiental para a imersdo no mar.
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Exercicio 5 3
REGISTO TEMPORAL DA POSICAO
DE NAVIOS

Objetivos
Neste exercicio trabalhara com dados espacio-temporais, i.e. cuja informa-
¢ao varia no espaco e também no tempo.

Tera acesso ao posicionamento de navios junto a costa portuguesa durante
1dia, com os quais ird explorar as ferramentas de visualizacdo do ArcMap,
para dados temporais, e efetuar alguns procedimentos de analise como
calculo de velocidades, rumos e conversao de posicionamentos de pontos
para percursos (linhas).

A. CRIARUMA FILE GEODATABASE E ADICIONAR DADOS

1. Abrir o ArcCatalog e navegar até a pasta onde ira realizar o exercicio 5, criar
uma File Geodatabase:

1.1 Carregar com BLDR e fazer New » File Geodatabase.
1.2 Nomear a sua base de dados.

2. Adicionar a tabela de posi¢oes de navios na costa portuguesa (“Posic_navios.
csv”) a sua base de dados, através de uma das seguintes opgoes:

2.1 Através do ArcCatalog, carregar com o BLDR sobre a geodatabase e
fazer Import »Table (single) (Figura 1).

Name Type Input Rows ~ | Tableto Table
[& | MaviosCosta.gdb 5 £iL D:1SOPHIAModio_AE [Exercicios [Exercicio#|Dados'DG| |4
Copy c+C Converts an input table to a
oty dBASE or geodatabase table
D:\SOPHIA \Modulo_AE \Exercicios\Exerdicio#\Dados_ed |4

X Delete Output Table
Navios_Pos_table

Refresh F3 Expression (optional)

F]
0

Administration

Field Map (optional)
e

Distributed Geodatabase

x| 4+

New

Import
Export

Feature Class (single)...

Feature Class (multiple)...

« [+

Share as Geadata Service... Table (single)...

Z W

Properties. Table (muttiple)..

Import Table (single)
Raster Datasets... = =

Import a table into this R

geodatabase.

oK Cancel Environment ts. << Hide Help Tool Help

Figura 1 - Importar dados para a base de dados através do ArcCatalog.
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2.2 Através do ArcMap, adicionar a tabela ao projeto ArcMap, carre-

gar com BLDR sobre a tabela e fazer Data »Export. Na caixa para a
gravacgao dos dados escolher o local de gravagéo na Geodatabase criada,
certificar que o tipo de dados ¢é File and Personal Geodatabases tables.

3. Definir a Geodatabase criada como base de dados padrao para a gravagao de
novos dados.

3.1 Em ambiente ArcMap abrir o Catalog carregando em Gl ou em Win-
dows P Catalog. Navegar até a base de dados criada para este exercicio
e com BLDR fazer Make Default Geodatabase.

4. Converter a informacgao tabular em informacgao vetorial, na qual a informacao
esta representada espacialmente por pontos:

4.1 Com o BLDR sobre a tabela de dados fazer Display XY data e definir
o sistema de coordenadas WGS84 (sistema em que os dados originais se
encontram referenciados).

4.2 Verificar, na tabela de atributos da camada temporaria (Events), se a
informacéao esta correta e se estiver tudo bem exportar a camada para a

sua Geodatabase.

4.3 Adicionar o mapa base (Basemap) Oceans disponibilizado pela ESR/
online (Add Data » Add Basemap).

5. Explorar os dados, sabendo que o campo Cédigo descreve Navios distintos.

6. Onde exerceram as suas atividades piscatorias os navios com cédigo 3, 13,
133,233 e 313.

6.1 Utilizar a selecdo de dados por atributos “Query builder”.

B. ATIVACAQO DA FUNCIONALIDADE TEMPO NAS CAMADAS
DE DADOS

7. Ativar as funcionalidades de tempo disponiveis para camadas de dados com
atributos temporais.
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7.1 No separador Time, da caixa de propriedades da camada com o posi-
cionamento dos navios, ativar o campo Enable time on this layer (Figura
2). (Nota: devera remover as expressdes de selegao efetuadas no ponto
anterior para que a totalidade dos dados seja representada).

7.2 Preencher os diferentes campos de Time Properties de acordo com
0 que conhecer acerca da tabela de atributos e sabendo que os dados

representam 1 dia de posicionamento de navios.

7.3 Ativar a opcéao Display data Cumulatively.

| General ISource | Selection | Display I Symbology | Ficlds I Definition Queryl Labels | Joins & F!elatas‘ Time | HTML Popup

Enzbie time on this Jayer!
Time proper ties

Layer Time: ‘Eadn feature has a single time field v |

Time Field: ‘nmejmmp W | Sample: 10/06/2015 08:05:00
Selected field is not indexed. Index the fields for better performance.

Field Format: ‘ <Date/ Time > w |

Time Step Interval: ‘ 0.00 ||Hours V|

Layer Time Extent: To: Calculate

[[Data changes frequently so calculate time extent automatically,

Advanced settings

Time Zone: ‘ none v |

Values are adjusted for daylight savings

Time Offset: ‘o || vears v

[ Display data cumulatively

| oK || Cancelar || Aplicar |

Figura 2 - Ativar a funcionalidade tempo numa camada de dados.

8. Ativar a ferramenta de visualizagao de dados temporais Time Slider, carregan-
do no icone [0, apresentado na barra de ferramentas.

Igli=lE=s - © 10/06/2015 08:05:00 =+

Q) [l[»

4 10/08/2015 08:05:00 11/06/2015 09:05:00 > |{D

8.1 Observar a variagao espacio-temporal dos dados explorando as dife-
rentes opcdes de Time Slider.

8.2 Quais as areas com maior densidade de atividade piscatéria?

8.3 Repetir a agao anterior, filtrando os dados para apresentar apenas
alguns navios.
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C. CALCULO DE VELOCIDADE E RUMOS

O ArcMap permite o calculo de velocidades e rumos associados a dados que contenham
variagoes temporais de posi¢cao. No caso deste exercicio € possivel calcular a velocida-
de dos navios e os respetivos rumos utilizando a ferramenta Track Intervals to Feature.

9. Calcular a velocidade e rumos das embarcagoes
9.1 Utilizar uma projegao de dados que |lhe paregca adequada.
9.2 Calcular os parametros pretendidos com a ferramenta Track Intervals
to Feature disponivel na toolset Tracking Analyst Tools. Utilizar unida-
des nauticas (distancia — milha nautica; tempo — horas; velocidade — nés e

rumo — graus).

9.2.1 Qual a velocidade média, velocidade maxima e rumo médio das
embarcacgdes 3 e 137?

D. CRIACAO DE PERCURSQS

10. Criar uma linha que represente o percurso de cada um dos navios com a fer-
ramenta Track Intervals to Line da toolset Tracking Analyst Tools. Nao esquecer
de definir como identificador de cada navio o campo “codigo”.

E. MAPAS DE DENSIDADES

11. Produzir um mapa de densidades com as posi¢oes de navios.

11.1 Tentar encontrar a ferramenta do ArcToolbox que realize a agao
pretendida e usa-la para produzir um mapa de densidade de posicoes de
navios.
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F. INTERCECAQ DE ATIVIDADE PISCATORIA COM AMP'S

12. Identificar as embarcagoes que poderao ter exercido atividade piscatoria na
AMP da Nazaré. Utilizar como critério de pesquisa os navios que demoraram
mais de 2 horas a percorrer 1milha nautica'.

12.1 Adicionar a camada de dados com a AMP da Nazaré disponibilizada
na pasta de dados do exercicio.

12.2 Selecionar os dados/embarcagdes que durante o periodo em analise
intersetaram a AMP Nazare.

12.3 Quais as embarcagdes que demoram mais de 2 horas a percorrer 1
milha nautica (equivalente a uma velocidade inferior a 0.5 n6s)?

" Este valor é indicativo; podera utilizar um outro valor de referéncia.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL

84






Exercicio6
INTRODUCAO AO GEOPROCESSAMENTO
AUTOMATICO

Objetivos
Este exercicio tem como objetivo apresentar uma introducdo ao geoproces-
samento automatico.

Pretende-se que o utilizador crie um modelo que corra automaticamente
uma sequéncia de tarefas de sele¢ao, neste exemplo repete-se o processa-
mento realizado no exercicio anterior, em que se selecionam os navios que
permanecam determinado tempo dentro de uma area com algum tipo de

restricao.

No final deste exercicio, o modelo criado devera processar automatica-

mente diferentes passos, possibilitando ao utilizador escolher diferentes
areas de restricdo e a condicdo de velocidade.

A. ABRIRUM PROJETO ARCMAP E ADICIONAR CAMADAS DE
DADQOS

1. Abrir um novo projeto ArcMap e adicionar os dados com as posi¢coes de na-
vios utilizados no ultimo exercicio.

2. Adicionar as areas marinha protegidas: Madeira Tore, Nazaré, Espichel e S.
Vicente.

B. CRIAR MODELO DE PROCESSAMENTO AUTOMATICO

3. Carregar no icone ModeloBuilder # para abrir a janela de construg¢ao do Mo-
delo de geoprocessamento (Figura 1).
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Model Edit Insert View Windows Help

6 88 x

Figura 1 - Janela de construgéo do modelo de geoprocessamento automatico.

4. Adicionar a primeira acdo ao modelo.

Pretende-se, nesta primeira agao, criar uma nova camada de dados que contenha ape-
nas os pontos (posicdes de navios) que se incluem na Area Marinha Protegida (AMP) da
Nazaré (a semelhanga do que fez no exercicio 5).

4.1 Procurar, no ArcToobox, a ferramenta Clip e arrastar para dentro da
janela do modelo.

4.2 Adicionar ao modelo os dados que ira “cortar” e a area de corte (Posi-
¢Oes dos navios e AMP da Nazaré, respetivamente), arrastando-os para o
seu modelo.

4.3 Fazer duplo clique na ferramenta Clip e definir os parametros da ferra-
menta, utilizando as camadas que se incluem no modelo (representadas
pelo simbolo &} ). Definir em Output Feature Class o nome e local de
gravagao da camada de dados resultante.

4.4 Uma vez que os parametros de entrada desta ferramenta constituem
parametros que no futuro queremos variar devemos defini-los como
Model Parameters.

4.4.1 Carregar com BLDR sobre os paramétros de entrada da ferra-
menta Clip e carregar em Model Parameter.
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Ao definir parametros do seu modelo como Model Parameter (Figura 2), ao correr
o0 modelo este da-lhe a possibilidade de alterar estes parametros (ou camadas de
dados).

Open... »
Model Parameter |

Model  Edit Add To Display

H% Qﬂn @% NLErMediate (ﬂs_‘ﬁl k i_, J ’

Create Label

Ins:

View Messages...
Cut

Copy
Delete

Rename...
Switch To Picture Symbol
Display Properties...

Properties...

Figura 2 - Definigdo de parametros do modelo.

4.5 Configurar a adigdo automatica, ao projeto ArcMap, da camada de
dados resultante do processamento.

4.5.1 Com BLDR sobre a camada Output fazer Add To Display.
5. Testar a execugao do modelo de processamento.
4

5.1 Validar o modelo para verificar a existéncia de erros, carregando em
(Validate Entire Model).

5.2 Correr o modelo construido carregando em  (Run) e verificar se a
camada de dados “cortada” foi adicionada ao seu projeto.

6. Gravar o modelo de processamento automatico.
Para gravar o modelo de geoprocessamento criado, devera criar uma toolset propria, na qual

se incluird o modelo.
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6.1 Fazer save e na caixa de gravagao criar uma nova Toolbox (nomea-la)

e gravar o modelo (Figura 3). Fechar o modelo.

e Model

Look in: 5] Home - Exercicios\Exerdidos v 4 G} Lﬂn| E5s | Ell B v ~

E Dados
Sophia_AE.thx

MNew Toolk

Mamne: | Model

Save astype! | 1ggls

Figura 3 - Criagdo de uma nova Toolbox para alojar o modelo de processamento criado.

7. Adicionar a Toolbox que aloja o modelo de processamento e experimen-

tar o modelo com diferentes AMP’s.

7.1 Carregar com BLDR sobre o organi-
zador ArcToolbox (dentro do ArcToolbox)
e fazer Add Toolbox. Navegar até onde
gravou a Toolset e adicione-a.

7.2 Experimentar o modelo com varias
AMP’s'. Carregando no modelo criado que
devera aparecer na Toolset adicionada.

ArcToolbox X

! Wﬂdd Toolbox...
& ar

a Ar ﬁ Ernvironments...

@ C[v]| HideLocked Tools

B C Save Setti
3

@ D: ave ings

a Dz Load Settings 3

&3 Editing Tools

B3 Geccoding Tools

@ Geostatistical Analyst Tools

8. Adicionar uma nova ag¢ao ao modelo, que permita selecionar as embarca-
¢oes que naveguem a uma velocidade inferior a 0.5 nés.

8.1 Carregar com o BLDR sobre o modelo e fazer edit.

" Caso o seu projeto ArcMap ndo permita a gravagéo “por cima” de dados com o mesmo nome, devera configurar essa

possibilidade (ver a informagéo).
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8.2 Adicionar a ferramenta Select ao seu modelo. Configurar as opgdes
da ferramenta.

Para configurar a regravacao de ficheiros com o mesmo nome, em

ArcMap, devera ir a Geoprocessing » Geoprocessing Options e ati-
var a fungao Overwrite the outputs of geoprocessing operations.

8.2.1 Selecionar a camada de dados “cortada” como input da ferra-
menta Select (utilize a opgdo connect ' para ligar a camada de
dados a ferramenta).

8.2.2 Definir a condicao de selegcao que pretender com duplo clique
na ferramenta (velocidade < 0.5) e configurar a camada resultante do
processamento para ser visualizada no projeto ArcMap.

8.3 Gravar as alteragdes e verificar se o0 modelo esta a funcionar.

9. Criar um parametro de entrada que represente o valor limite para a ve-

locidade dos navios. Esta configuragao permitira ao utilizador do modelo
configurar o valor da condigao de selegao de pontos sempre que correr o
modelo.

9.1 Com BLDR sobre a area vazia do modelo fazer Create Variable e
selecionar uma variavel do tipo Double, designar por “velocidade limite” e
definir como parametro do modelo.

9.2 Editar a expressao de selec¢ao da ferramenta Select no seu modelo
por forma a utilizar o parametro “velocidade limite” no critério de selegao.

Alterar a expressédo SQL utilizando a terminologia %velocidade limite% para ace-
der ao valor inscrito neste parametro.

9.3 Definir a camada de dados resultante do geoprocessamento automa-
tico como parametro do modelo, por forma a permitir a gravagao desta
camada de dados com um nome definido pelo utilizador.

SISTEMAS DE INFORMAGAO GEOGRAFICA: ANALISE ESPACIAL

90



Model Edit  Insert View Windows Help

& +HB X0~ B RIKS P

Figura 4 - Aspeto geral do modelo de geoprocessamento automatico

10. Correr o modelo para diferentes areas de restricao e com diferentes cri-
térios de velocidade.
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Exercicio7
PUBLICACAO DE MAPAS NA INTERNET

Objetivos

Neste exercicio ira efetuar a disponibilizacdo de dados na internet através
de um servico de mapas utilizando o ArcGIS Server.

A. ABRIRUM PROJETO ARCMAP UTILIZADO ANTERIORMENTE

1. Abrir um dos projetos ArcMap apresentados na pasta do exercicio, podera
escolher uma das 3 versoes apresentadas (Figura 1, Figura 2 ou Figura 3) ou em
alternativa escolher um projeto gravado anteriormente.

a Ex7_v1.mxd - ArcMap [= el

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

DBE& BB x|0cld-[Bms v EEEROIE g & B KPS PEY

QAFQ i« F-O /8@ ZIRBR TR Georeferencing - " RiLAREQ-_
& @M S EE e - E‘Lqé‘@@i Editor=| » M |/ 0 Ll- I Hach 7 A B

© 3D Analyst ~ =
Table Of Contents LS = i A
se8 3
B £ layers

Reference
EHZ] £guasMarinhas PT_dissolve

[ Mar Territorial

177 Zona Econsmica Exclusiva

1 Extensio da Plataforma Continental
W] CA0P wos dissolve|

5 & Basemap
Ocean/World_Ocean_Base

[somies oo | [Goieos &l [moawoLory @) [sinson B

Figura 1 - Projeto 1
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Q

DedEs
aa@o

Ex7_v2.mxd - ArcMap [ re =]
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
B x b - ([1:18980575 Y EEEER Fgie B HE 095 =
P WOk @ PR RITIE Georeferencing~ H A LEEQ 1
118 oo L!'ét"ﬁ_z, Editor~ | » M 2 AR |2 B =

&P G

Table Of Contents £ x

B

3D Analyst ~ ]/ LEE2IR- @ @®.

= = layers
5 @ Seamounts  Estrururas Geologicas
= B Seef_seamouts PT

= @ Gebeo_seamouts PT
= B Gebeo_estGeo PT

5 @ AguasMarinhas PT_dissolve

[ <all other values>

Descritivo

[ Mar Territorial

I Zona Econémica Exclusiva

M Extensio da Plataforma Continental
& @ Basemap

= B World_Imagery
World Imagery

Low Resolution 13m Imagery
High Resolution 60cm Imagery
- High Resolution 30cm Imagery
Citations

[someagaiain B [uoieos @ll| [xosiooson ]| [shmsont B

< >|j@e | e n <
Drawing = K ) 2| O - A - 7% |[[@] Atal vt VB rUlA-B-2- -
-3982352.263 3036806.467 Meters

Figura 2 - Projeto 2
Q Ex7_v3.mxd - ArcMap o [ =R
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

OD2Ea& B x| o [TmEs VRO @ E R HIS 5 B

CRCTE TR e Ok @ ZIAARTEY Georeferencing © (A AREAQ- g

Gils BR E Wl O] @ B g ¢ Editor-| » L1~ s f E

Table Of Contents i g

Elass

3D Analyst~

(=) £ Layers
© @ Reference
= @ Ocean/World_Ocean_Reference
World_Ocean_Reference
© @ Navios_pos_pts
5 @ CAOP_continente

5 & AMPs
= @ ampl5_svicente

O
= @ ampl4_espichel
O
o B ampl3_nazsre
B & AMP12_Madeira_Toret

© & Basemap
Ocean/World_Ocean_Base

Madrid

Drawing= K (73 & 0+ A - < [0 Ata vt VB 1 ulA-N-2 .-
-20.916 33.628 Decimal Degrees

Figura 3 - Projeto 3

i

No caso de ter optado por abrir um projeto anteriormente gravado
por si, remover as camadas de dados no modelo matricial (apenas
iremos publicar dados vetoriais) e simplifiar ao maximo o seu projeto
(i.e. remover todas as camadas auxiliares que estao inativas) man-
tendo apenas as camadas de dados que quer publicar.

[saimieasaieain ]| [uoeas l]| [xomioorony @] [sunsex B]|
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B. ADICIONAR UM SERVIDOR SIG

2. No Catalog adicionar um Servidor SIG (ArcGIS Server) com capacidade para
publicacao de servigos GIS (Figura 4).

Ialalog 0o x

v bl B Ec| e | E

Location: |\'_"1:| Add ArcGIS Server

vl

&) Home - Exercicios\Exercicio7

3 Folder Cennections

Bl Toolboxes

(7l Database Servers

5l Database Connectiens

= [F GIS Servers

Add ArcIMS Server

Add WCS Server

Add WMS Server

Add WMTS Server

arcgis on 194,117.43.26_6080 (publisher)
CGC Servidor WMS5 on www.igeo.pt

Gelr| CGC Servidor WMS on www.igeo.pt (2)
Q: Ortos 2010 do litoral on mapas.igeo.pt
My Hosted Services

Ready-To-Use Services

Ea Tracking Connections

o i el

Figura 4 - Adicionar um ArcGIS Server.

GIS services.

What would you like to do?

() Use GIS services

() Administer GIS server

This wizard guides you through the process of
making a connection to an ArcGIS Server. You can
create a connection to use, publish, or administer

< Anterior

Seguinte = | | Cancelar

2.1 Na configuragao da ligagao utilizar o servidor da FCUL
(http://194.117.43.26:6080/arcqgis/admin) com as op¢des indicadas na figu-

ra seguinte (exceto a definicao da pasta Staging Folder) (Figura 5).

General

Server URL:

Server Type:

Staging Folder:

Authentication

User Mame:

Password:

| http: /194, 117.43.26:6080/arcais/2dmin |

ArcGIS Server: http://gisserver.domain.com:6080/arcgis

|ArcGIS Server w |

| C:\Users\aninha\AppDataLocal\Esri\Desktop10 .2‘!5| [:.1

Use ArcIS Desktop's staging folder

| MGA20142015 |

Save Username/Password

About ArcGIS Server connections

X

| < Anterior " Finish I | Cancelar

Figura 5 - Configuragdes gerais do ArcGIS Server.
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Apos a execucao do passo anterior, devera ter surgido um servico no Catalog respetivo

a ligacao configurada. Devera ainda verificar a existéncia de uma pasta relativa ao proje-

to SOPHIA.

C. PARTILHAR O PROJETO ARCMAP

3. Partilhar o seu projeto ArcMap em File » Share As W Service.

3.1 Escolher a opcéo Publish a Service e depois carregar em Seguinte.

3.2 Selecionar a ligagéao ArcGIS criada no ponto 2; e denominar o servigo
com SOPHIA seguido de iniciais do seu nome. (ex SOPHIA_ANS), fazer
Seguinte e escolher a pasta SOPHIA e depois carregar em Continue.

3.3 Na janela Service Editor definir as propriedades do servigo e em
Capabilities selecionar as opgdes representadas na figura seguinte

(Figura 6).

Service Editor

Connection: arcgis on 194.117.43.26_6080 (publisher) Service Name: MyMapService

Ez Import o Analyze @ Preview 17 Publish @

General
Farameters
Capabilities
Mapping
KML
Pooling
Processes
Caching
Item Description

Sharing

Capabilities

Choose the capabilities you would like enabled for this service:

[ wics

1 wms

I:‘ Feature Access
[] schematics

[] Mobile Data Access
[ network Analysis
KML

[ wrs

Mapping (always enabled)

Figura 6 - Configuragdes em Service Editor, para a publicagéo de servigos na internet.
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3.4 Carregar em Analyze para verificar se 0 documento pode ser publica-
do no servidor. Todos os erros assinalados deverao ser corrigidos.

3.5 Publicar o servigo (Publish) aceitando a copia de dados para o servi-
dor.

3.6 Depois de concluido o processo anterior o servigo encontra-se
ativo. No entanto, para poder ser utilizado por qualquer utilizador

tem de ser desbloqueado. Nesse sentido, no Arcgis server manager
(http://194.117.43.26:6080/arcgis/manager/), abrir o cadeado associado
ao servico que criou.

Selecionar a opcao Public, available to everyone.

@ ArcGIS Server Manager %
&« C' | [1 194.117.43.26:6080/arcgis/manager/#f=SOPHIA T Bvy W E
esri.com | Resource Center | Sian Out | Help -
@ ArcGIS Server Manager m Site Security Logs.
OGC Services KML Network Links Sharing
Folders C3l ["Publish Service | (£¥|

Site (root) o Permissions applied successfully %
& MGA2015
SOPHIA ANS # (Map Service) @ Adrmx

b
Status: Started

. SLG2014

8 SOPHIA asx

§ | Instan unning 1
“ | Instances in Use 0
Maximum Instances: 2

i system

& Utilities

Figura 7 - Gestao do servigo publico no ArcGIS Server manager.

D. UTILIZAR O SERVICO QUE PUBLICOU ATRAVES DA
INTERNET

4. Utilizar o servigo no ArcMap, Google Earth ou noutra aplicagao que tenha a ca-
pacidade de visualizar servigos de mapas. Nesse sentido, introduzir o endereco
representado em REST URL (Figura 8) na barra de navegacao do navegador e
selecionar a aplicacao onde pretender visualizar os dados (Figura 9).
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' & ArcGIS Server Manager

« S

C' | [3 194.117.43.26:6080/arcgis/manager/service.html?name=SOPHIA_ANS MapServer&folder=SOPHIA

esri.com | Resource Center | Sign Out | Help

O ArcGIS Server Manager m Site Security Logs
OGC Services Sharing
Editing: Site (root) > SOPHIA > SOPHIA_ANS Help | Save and Restart | [ Cancel |
General
Parameters Select and configure capabilities
Mapping (always enabled) wes
Pooling = wMs Feature Access
Processes Schematics Mobile Data Access
Caching Network Analysis 2 KML

Item Description WFS

Mapping Configuration

URLs
REST URL:
SOAP URL:

http://104.117.43

Ihttp://194.117.43.26:6080/arcais/rest/services/SOPHIA/SOPHIA ANS/MapServet

cais/services/SOPHIA/SOPHIA ANS/MapServer

Operations Allowed

@ Map & Query
Figura 8 - Caminho URL do servigo de mapas criado.

€ - C' [ 194.117.43.26:6080/arcgis/rest/services/SOPHIA/SOPHIA_ANS/MapServer

@ Data

B o) W

ArcGIS REST Services Directory

Login | Get Teken

Home > services > SOPHIA > SOPHIA ANS (MapServer)

Help | API Reference

JSON | SOAR | WS

SOPHIA/SOPHIA_ANS (MapServer)

View In: ArcGIS JavaScript ArcGIS.com Map Google Earth ArcMap ArcGIS Explorer

View Footprint In: ArcGIS.com Map
Service Description: b

Map Name: Layers

Legend

All Layers and Tables

Layers:

» AguasMarinhas PT dissolve (0)
= CAOP wgs dissolve (1)

Description:
Copyright Text: b

Spatial Reference: 4326 (4326)

Single Fused Map Cache: false
Initial Extent:
XMin: -47.392650562091504

YMin: 40.783994656090634
XMax: -13.836141451482192

Figura 9 - Selegéo da aplicagao para utilizar o servigo publicado.

5. Partilhar o enderecgo dos servigos que criou com os seus colegas e visualizar

os servicos disponibilizados por eles.
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